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 QuickCogo  
 Coordinate Geometry Software 
 
INTRODUCTION 
 
Welcome to QuickCogo.   This is a stand alone coordinate geometry (Cogo) program 
designed for those who are familiar with the Windows operating systems and with Cogo itself. 
This version only runs on Windows 9.x and above.  The program consists of many Cogo 
routines that carry out specific tasks related to surveying and engineering.  Although the 
routines are separate they work with the same file or database and remain active until closed. 
This software does not work "within" any other software, such as CAD or GIS programs but 
there are routines within the program that create files such as DXF and ASCII which allow 
users to effectively work with other programs.  Although QuickCogo  is not intended to be a 
CAD mapping program, it has several routines that will plot points and figures on the screen 
and to scale to your windows printer.  Each routine has its own separate window that receives 
input and displays results. Local help is available within each routine or from an alphabetized 
list accessed through the help menu.  When activated, many routines also contain a brief 
description of what they do and how.  Most routines are self-explanatory and will be simple to 
follow for those familiar with coordinate geometry.  A part of this manual is devoted to 
explaining some basics of coordinate geometry and the way QuickCogo uses them.  
 
INSTALLATION  
If the program was received via download, the installation instructions were contained in an 
accompanying message. If it was received on a CD the installation instructions were included 
in an accompanying letter as well as on the label of the CD. 
 
GETTING STARTED 
After installation you should transfer the program’s icon to your desktop for easy access. The 
name of the executable file is “qc<month, day and year created>.exe”, e.g. qc030104.exe .  It 
will be found in the folder where you installed the program. When located, right click it and 
select Send To, Desktop, create shortcut. After doing so, verify that the correct path to the 
program is displayed in the “Start in” box within the Shortcut tab. To do this, right click the 
program’s desktop icon, select properties , select shortcut. If the “start in” box is empty, 
manually enter the path, which would be “C:\Program Files\QuickCogo” if installed in the 
default folder.  You may double click the icon to begin the program or double click it from the 
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folder where it resides. QuickCogo’s  startup window appears. This window contains 
developer contact details and instructional information to get started.  First time users should 
check the box at the left of the screen and read/print the information that displays.  
 
Cogo routines operate within their own window but are displayed within a larger window. At 
the top of this larger window are menus applicable to all routines rather than each routine 
having its own.  After continuing from the startup window, the open file dialog is displayed 
where you must open either an existing file or begin a new one before the program is fully 
operational.  Although there are several routines that do not use coordinates or a file, the 
menus and button bar will be disabled until a file is opened. The “open file” dialog should be 
familiar to you from other windows applications you have used.  You may change drives, 
folders, etc. to find the file you want.  To open a new file, simply type its name in the box at the 
bottom of the window.  An extension will be added according to the ‘type’ noted in the box 
beneath the ‘File Name’ box.  If it is a coordinate file, it will then be the default for all cogo 
routines that use coordinates. To open another coordinate file or start a new one, you may 
click 'File, ‘Open’ or use ‘Open’ from the button bar at any time.  You may also import an ascii 
file from another program using the ‘Import’ routine after the program is functional.  Generally, 
an initial file named "sample.qcw" will be placed in the installation folder and displayed as one 
of the files after clicking “Continue” from the opening screen.   After a file is selected or 
named, a cogo routine or another item from the menus may be selected. Since the windows of 
the various routines are of different sizes and are limited to the area within the larger window, 
the window containing the routine may not appear as full size after you select it but can easily 
be enlarged and moved. The quickest way to resize it is by clicking the 'Maximize' button (the 
small square next to the close (x) button in the top right corner of the window). You may also 
resize it by using your pointing device and expanding it in either direction when the 2 small 
arrows are on the border of the window. Whenever you minimize a window by clicking the 
dash (-) left of the small square, its icon will be displayed at the bottom of the larger window 
rather than in the system tray. It can then be recalled by clicking one of its restore buttons. 
They will also be listed at the bottom of the ‘File’ menu. When you become familiar with this 
method you will find it more convenient than having the system tray filled with icons from the 
program. You may also cascade or tile multiple windows by selecting one of those options 
from the 'Window' menu. The program was designed for a screen resolution of 800x600 or 
higher. If you are using 640x480 some parts of the windows of several routines will not be 
visible. Change your resolution for best results. Please explore the various items from the 
menus and review their use. Try some "canned" problems for which the answers are known to 
aid in determining how the particular routine works. 
 
Help for an active routine (the one you are using) may be obtained by pressing CTRL+F1. It 
acts as a toggle for the help text that appears. A list of all help topics may be obtained by 
pressing F1. Both of these methods are also available when you select ‘Help' from the main 
menu. You may print the help topic from the "All topics" menu or from the "Print" selection 
under the "File" menu. When an individual routine has its own 'Print' button, you should use it 
to print the output from that routine. 
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 Each routine is contained in its own window or screen and works independently from other 
routines.  After completing the routine, you may close it or reduce it to an icon for later use. 
You can have several routines running at the same time, but can work with only one at a time. 
Each active routine will maintain its data if you did not close it.  Each opened routine will 
appear at the bottom of the File menu and must be selected from there until it is closed.  You 
may also cascade or tile the routines from the Window menu for easier selection. 
 
CONVENTIONS AND GUIDELINES 
Familiarity with the Windows operating environment will greatly enhance your ability to use this 
program effectively but this manual will not teach you how to use Windows.  Please refer to 
your Windows User's Guide when needed.   
 
Screens of some routines may not match those represented in this manual although the 
functions are essentially the same. 
 
ALL routines are chosen from the menus or button bar, both of which remain visible throughout 
the session. The button bar may be toggled off and on with Ctrl+F12. 
 
Either upper or lowercase letters may be used when entering text. 
 

Each routine's window has an OK or similar button that executes the routine after data 
has been entered.  This button may be accessed by pressing ENTER when it has the 
focus, clicking on it with the left mouse button or holding the Alt key and typing the 
underlined letter.  Close and Clear or Reset buttons are also included in most of the 
routines.  The Close button exits you from that routine and the Clear or Reset button 
clears the data and display boxes.  You may also click the “x” in the upper right corner. 
 
Most cogo routines contain brief instructions for that routine in addition to help.   
 
Press Ctrl+F1 for help for any current routine or F1 for a list of topics.  You may type the 
first few letters of the topic and it will come to the top of the list until the topic box is filled. 
"Printing" is the top item of the last full screen.   
 
Columns of results may not line up on the screen but will in the printed results. 
 
Headings above several display boxes indicate the order in which the data is presented 
and were designed for the maximum number of characters. Data itself may not be aligned 
with the columns. 
 
PRINTING 
The results from most of the routines may be printed.  This is done by simply clicking the 
Print button. The output is made with the 10 point Times New Roman font, which seems to 
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accommodate most of the data and results of calculations. Although the screen font can 
be changed to suit your own tastes, the printer font can not.  Basically, everything that 
shows in the display is printed, but if you want supplemental items, contact me and I will 
customize it for you. There is the ability to create your own heading for the printed pages. 
Select it from the Edit menu for set-up and from the Options menu to cause it to print on 
your outputs. The menu item Printer allows you to configure your printer. The default is 
the printer set up when Windows was configured.  If a routine is closed with pending 
output to the printer, the output will automatically be sent.  
 
Open files using the Open button in the button bar or File, Open menu item if you need to 
browse for a file.   
 
In most cases if invalid data is entered into a text box, a message informs you of that fact. 
Erase the invalid data and re-enter. 
 
The ENTER or TAB key (or pointing device) may be used to move from box to box for 
data entry.  In most cases, the boxes are arranged so that either key will move you to the 
next logical entry.  After all data has been entered, you may execute the routine by 
pressing ENTER if the focus is on the OK button.  
 
The vertical bar flashing in a box is the cursor and creates the focus in that box.  You may 
reset it in any box that accepts data by clicking within that box, tabbing to it or pressing 
Enter until you are there.  Data that exceeds the visible part of the box can still be viewed 
by using the right and left arrow keys while the cursor is in the box.  Shift+Tab moves the 
cursor to the previous data entry box. Start data entry from the far-left side of each box. 
 
Vertical scroll bars are provided for the windows of those routines in which data may 
extend beyond the bottom of the window.  The up and down arrows will scroll the data as 
will moving the scroll bars. 
 
Shortcut key combinations are listed to the right of a menu item.  Instead of opening the 
menu and choosing a command, you simply press the key combination. 
 
Data input windows will pop up when more data is needed.  Enter the data and press 
ENTER to close the window. 
 
Tool tips are included with many controls, entry boxes or command buttons. Hover the 
pointing device over the control and read the explanation of its use. 
 
Several routines contain entry boxes where a range of points or random points may be 
entered. Generally, the range of points is separated with a dot and random points with a 
space. 
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 QUICKCOGO BASICS  
 
The following information is provided to give users an understanding of the 
terminology and operation of the program. 
 
When QuickCogo was first designed the only method for entering bearings, 
azimuths and angles was without punctuation (a decimal after degrees).  It was 
meant to save keystrokes and worked without complaint for many years.  Now, 
however, a new coding method was found that will allow other options for those who 
prefer to maintain their present way of entering that data without any special settings 
of preferences.  The other options are discussed hereafter.  
 
ANGLES  (General) Also see azimuths and bearings 
Angles are measured and entered as degrees, minutes and seconds.  They must 
have at least 2 digits but not more than 7, except when using decimals of seconds.  
Degrees may have 2 or 3 digits, but minutes and seconds must have 2 digits each 
(seconds may have decimals of seconds). The angle entry may contain only the 
degrees (at least 2 digits) or degrees and minutes or degrees, minutes and seconds. 
Certain routines may require an angle entry of 7 digits only. If in doubt, enter 7 
digits.  Angles may be added to or subtracted from azimuths and bearings as 
described hereafter. 
Examples: 123456 or 12.3456 = 12°34’56”, 08 = 8°, 2156 or 21. 56 = 21°56’, 
2511802 or 251.1802 = 251°18’02”. The program detect s the number of characters 
and makes the adjustments.  Note: Only the “no decimal” option may be used when 
adding or subtracting angles from bearings and azimuths in the bearing-distance 
traverse as part of the Embedded Routine. 
 
The angles described above are horizontal.  VERTICAL ANGLES may also be used. 
They are activated as soon as a slope distance is entered. (See DISTANCE 
discussion).  Vertical angles are measured from the Zenith (straight up) and are 
entered as either 6 or 7 digit numbers.  Vertical angles less than 90° are above 
horizontal, those over 90° are below horizontal.  The A ngle-Distance Traverse and 
Radial routines also allow a vertical angle to be referenced to horizontal being 0. 
Angles above horizontal are positive and those below are negative.  Check the 
applicable box to activate. The vertical angle is used to calculate horizontal and 
vertical distances (elevations).  Vertical angles must be entered without a decimal 
after degrees.   In the Radial and Angle-Distance traverse routines ONLY a check 
box has been added for those whose vertical angles are based upon horizontal as 
0°.  
 
AZIMUTHS and BEARINGS 
Azimuths and bearings will be discussed together, since they are very similar in 
nature and are interchangeable in the methods of entry as described hereafter.  An 
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azimuth is an angle from 0° to 360° measured clockwise fro m either due NORTH or 
due SOUTH as a reference line. Examples of azimuths are 23°14'18", 160°20'23", 
235°56'10" and 348°10'25".  Many surveyors use only azimuth s in their work.  

  A bearing is an angle from 0° to 90° measured eithe r clockwise or counter-clockwise    
from either NORTH or SOUTH.  Each 90° segment of the circle is known as a quadrant.  
Beginning at the top of the circle (NORTH), and going clockwise, the first 90° quadrant is 
1, the second is 2, the third is 3 and the last quadrant is 4.  It's like a pie being cut into 4 
slices.  Quadrant 1 contains all NORTHEAST bearings, quadrant 2, SOUTHEAST 
bearings, quadrant 3, SOUTHWEST bearings and quadrant 4, NORTHWEST bearings.  
0° is NORTH, 90° is EAST, 180° is SOUTH and 270° is WES T.  Some examples of 
bearings are N23°14'18"E, S19°39'37"E, S55°56'10"W a nd N11°49'35"W.  These 
represent the same directions as the azimuths in the previous examples, but now 
expressed as bearings. Angles in quadrant 1 will always be the same whether it's an 
azimuth or angle.  In quadrant 2, you would have to subtract the azimuth from 180° to get 
the bearing; in quadrant 3, you would subtract 180° fr om the azimuth to get the bearing 
and in quadrant 4, you would subtract the azimuth from 360° to get the bearing.  
BEARINGS are the default in QuickCogo .  The program starts in "bearing mode".  Turn 
azimuths on and off from the Options menu.  You may use either NORTH or SOUTH 
azimuths.  The whole degrees of azimuths must be entered with 3 digits.  Example: 004 or 
075 represent an azimuth of 4 degrees or 75 degrees, respectively.  Anything over 100 
obviously takes care of itself.  Displays of results in azimuths may only show 2 digits, 
however.  The Radial, Angle-Distance Traverse and Stakeout routines have their own 
means for accessing azimuth mode. 
 
The Embedded routines are called that because they do not need a separate window 
to be used. They are: bearing-distance traverse, inverse, bearing-bearing (line-line), 
bearing-distance (line-arc) and distance-distance (arc-arc) intersections.  
 
Both azimuths and bearings may be entered in several different ways.  The remainder 
of this section will address how this is done.  Throughout this instruction manual, 
whenever the term "bearing" is used, it also refers to "azimuth" unless otherwise 
noted. 
 
Activate azimuths by selecting from the Options menu.  When North is selected, South is 
turned off and vice versa. Remember to uncheck whichever one is active if returning to 
bearing mode.  Azimuths and bearings are entered in the BEARING/AZIMUTH box as a 3, 
5 or 7 digit number when using the bearing-distance routine in the embedded routines. 
The only difference is that the first digit in a bearing entry MUST be the quadrant if using 
that option of entry and the degrees of an azimuth must be entered as 3 digits. A valid 
bearing entry for N25°E could be 125 or ne25 or n25e whereas the valid entry for an 
azimuth of 25° would be 025.   Bearings less than 10 must have at least 2 digits, e.g. 107 
for N7°E.  When minutes and seconds are included they must  be entered as 2 digits 
each.  The quadrants are: 1=NE, 2=SE, 3=SW and 4=NW. Both azimuths and bearings 
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may also be entered by the same methods as described hereafter. A bearing of 
N34°23’12”W may be entered in any of the following w ays: 4342312 or 434.2312 or 
nw342312 or nw34.2312 or n342312w or n34.2312w.   Use the option that is most 
comfortable.  No preferences need be set. 
 
Decimals of Seconds: When bearings or angles are entered with decimals of seconds in 
the embedded, map check, angle-distance, radial and curve routines, the results will be 
calculated and displayed using that value and showing the decimals of seconds without 
any other action on the part of the user. Up to 4 places for decimals of seconds may be 
entered. When decimals are used, the bearing or azimuth is always displayed to 4 places. 
There is an item in the Options menu that can be selected to show the decimals in any 
other routine where a bearing, per se, is not entered. Inversing is a case in point where 
you would want to activate the option to display the results of the calculated bearing with 
decimals of seconds.  You can also toggle this option with Ctrl+Q.  At this time you are not 
able to add angles to point-numbered bearings in the embedded routines using decimals 
of seconds.  Note: Decimals of seconds may only be used with the “no decimal” and 
“quadrant” option.  Example: 1234523.4523 = N23°45’ 23.4523”E 
 
2) You may also enter a bearing by point numbers.  This means that the bearing is the 
inverse between the coordinates of the given point numbers.  These are entered by 
separating the point numbers with an asterisk (*).  An error message will inform you if one 
of the points is not in the file.  For straight inversing, which is done from the “Point from” 
box in the Bearing-Distance traverse routine, a dot (.) is also allowed between the point 
numbers.  However, the dot is NOT allowed between point numbers for bearing entry or it 
would interfere with the perpendicular to a bearing method described hereafter.  
 
3) You may add angles to or subtract angles from a bearing to create a new bearing only 
when the original is entered by point numbers.  For example: 23*45+125623 adds an 
angle of 12°56'23" to the bearing between points 23 and 45.  (Substitute - for + when 
subtracting).  In this case, angles MUST be entered without a decimal.  No spaces are 
allowed between the characters. Angles must have at least 2 digits (if no minutes or 
seconds).   
 
4) You may create a new bearing that is perpendicular to a known bearing defined by 
point numbers by entering a decimal and another digit after the point numbers.  For 
example: 10*14.1 will add 90° to the bearing betwee n points 10 and 14.  10*14.3 will 
subtract 90°.  You could use .2 to add 180° but its simpl er to just reverse the points. 
5) You may enter a stored bearing or a cardinal bearing by entering the number by which 
the bearing is stored.  You can store up to 99 bearings and recall them with a 2-digit 
number.  A cardinal bearing is NORTH, EAST, SOUTH or WEST.  These are stored as 
numbers 1, 2, 3 and 4 when selected from the Utilities menu.  If you are using these for a 
particular bearing frequently, it will save time to store the bearing(s) and enter only 1 or 2 
digits.  You may add, subtract or use the perpendicular method with a stored bearing. 
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6) Entering only an asterisk (*) in the bearing box will recall the previous bearing. 
 
IMPORTANT: The above entry criteria are also used for BEARING entry in routines other 
than the embedded ones, like Lot Closure/Map Check (3,5 or 7 digits OK), Street 
Intersections, etc.  However they are entered, they are then displayed as they would 
normally be written (e.g. N23°45'56"E).  
 
BUTTON BAR 
A row of buttons containing names of common cogo routines and features has been 
added below the menus.  These routines are also contained in the menus.  By simply 
clicking the one you want, it will open that routine.  The colored ones are those the 
developer considered the most common and given a color to stand out. Crtrl+F12 toggles 
the button bar on and off. 
 
COORDINATES 
QuickCogo  uses rectilinear coordinates.  They are expressed as accumulated distance 
units DUE NORTH and DUE EAST of 0,0.   For example, North 1000.000 and East 
1000.000 means that point is 1000.000 units North and 1000.000 units East of 0,0.  All 
subsequent coordinates produced as a result of your calculations will be relative to that 
origin.   The North coordinate is produced by adding the result of the distance multiplied 
by the COSINE of the bearing to the previous North coordinate.  The East coordinate is 
produced similarly by using the previous East coordinate and the SINE of the bearing. 
Each point in the file has at least a NORTH coordinate and an EAST coordinate. You may 
also enter them independently with the INPUT routine.  The default display for 
coordinates is 3 decimal places as is the distance, although they are calculated internally 
to a much higher precision. Displays throughout the program permit setting of decimals up 
to 5.  Having the coordinates of at least 2 points allows you to do several calculations to 
obtain bearings, distances, etc. between the points.  The coordinates of points also allow 
the easy plotting of those points on a computer screen using a Computer Aided Drafting 
(CAD) system or even manually on a sheet with a grid.   
 
DATA ENTRY AND CORRECTION 
Using the keyboard you may type data into the boxes in the window of the routine or by 
pasting from other sources.  You can use any of the editing keys to correct entry errors in 
any box before execution.  Use the TAB or ENTER key to move between boxes or click in 
the box with the left mouse key.  The vertical blinking line is the cursor.  
 
DESCRIPTORS 
A descriptor is an identifying label for a point.  It is limited to 20 characters, including a 
space as a character although you should avoid spaces when possible because they also 
act as delimiters and, when used with other programs, may cause problems.  It is 
recommended that you use an underscore to separate words in a descriptor.  Some 
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typical descriptors may be "rebar/cap", "top_ of_ slope", "NW_ prop_cor", etc.  If no 
descriptor is assigned, “None” will be displayed.   Descriptors are found in routines that 
create points.  The EDIT routine allows you to add descriptors if not done previously.  
Since alphanumeric points are not allowed, descriptors may also be used as a method of 
further defining the point numbers as though they were alphanumeric.  They may then be 
searched for using the ‘Find’ utility under the ‘Utilites’ menu.  Say you want to find the 
point numbers for all instances in which a station (like 25+00) was used in the descriptor.  
From the ‘Utilities’ menu select ‘Find’, enter the symbol “+” (without quotes) in the search 
box, click OK and all of the points with a descriptor containing that symbol will be 
displayed.  You then know which point can be used for further calculations.  You may use 
any combination of symbols, letters or numbers in your search.  You could have entered 
“25+00” in the search box and that single point would have been displayed. 
 
DISTANCES 
Distances are entered as units.  They can be feet, inches, meters, etc.  QuickCogo , 
however, provides the option during the area routine to choose feet or meters, the 
common units, so that the resulting calculation is in square feet and acres or square 
meters and hectares.  Other units of measure may be customized if needed. 
 
Distances are entered with as many digits as necessary.  However, the displays are 
designed for a maximum of 7 digits before the decimal.  Although the display rounds the 
distance to the number of decimal places selected, the calculation is made using your 
input.  If, for example, you enter a distance of 40.1357, the calculation will be made with 
that number, although the display will show 40.136 if 3 places were chosen.  If you have a 
distance of 40, you may enter just those 2 digits.  The display, however, will show 40.000 
after the calculation is made if 3 places were chosen. 
 
You may enter distances by point numbers, similar to the way bearings and azimuths are 
entered.  Simply insert an asterisk (*) between the point numbers.  This method of entry 
can be helpful if you are trying to maintain an exact distance, such as the radius of a 
curve. 
 
Independent calculations may be made during distance entry using the Windows on-
screen calculator. Select it from the button bar or use (Start, Run) enter c:\windows\calc in 
the blank box. It comes in both standard and scientific modes. You can do chained 
calculations, use trigonometric functions and more.  You then can copy and paste the 
results into QuickCogo’s  entry boxes.  
 
Distances are considered horizontal, unless you specify them as SLOPE DISTANCES. 
Slope distances are those which are measured along an incline either manually or 
electronically and are accompanied by a vertical angle.  (Vertical angles are explained 
under the previous discussion of ANGLES).  If you integrate both slope and horizontal 
distances in your routines, preceding the distance value with a Zero (0) indicates a slope 
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distance and tells the program to prompt for a vertical angle.  Slope distances are used 
primarily with instruments not equipped to automatically convert measured distances to 
horizontal.  If you are using slope distances exclusively, select it from the Options menu, 
and you will not have to enter the 0 as described above.  However, if there is a second 
distance in your routine, such as found in the bearing-distance or distance-distance 
intersection, you will have to enter that distance using the 0 method.  You can turn off 
slope distances by deselecting it from the Options menu.   
You can use a constant distance multiplier.  Select this item in the Options menu and then 
change the box that has the value.  The default is 1.  The multiplier multiplies all 
distances by that value.  This is an excellent way to convert rods, chains, grid distances, 
other distance units, etc. or simply to force a calculation for the ensuing entry. 
 
ELEVATIONS 
An elevation is a distance measured in a vertical plane from a given datum or benchmark, 
usually sea level.  It is the 3rd dimension of QuickCogo . The most practical use of 
elevations is in RADIAL SURVEY, FIELD TRAVERSE, GRADES and VERTICAL 
CURVES.   Calculations in these routines produce elevations for each point if desired and 
carry them as part of the data file.  They may be entered as 4245.56, 245.56, 45.56 or 
5.56, depending on the differences you anticipate will be generated by the routine. It is 
recommended that you plan not to have negative numbers for any elevation, if possible. 
Of course, this cannot be avoided in areas below sea level unless positive relative 
elevations are used.  Naturally, the more digits left of the decimal, the more complete the 
elevation.  However, a 7 character elevation (including the decimal) may be cumbersome 
when viewing a CAD screen full of elevation points close together.  Although elevations 
may be entered for information in the bearing-distance routine, they are not acted upon.    
 
ERRORS 
Every effort has been made to inform the user when an error or invalid entry has been 
made.  In most cases, a dialog box with a message will appear.  The user can then 
correct the problem.  However, since every eventuality of user input could not be 
anticipated, there may be occasions when an unforeseen entry causes the program to 
hang or terminate.  Please note what you were doing and report it. 
 
FILES AND FILENAMES  
The data files created and maintained in QuickCogo  consist of a point number, a north 
and east coordinate, an elevation and a descriptor.  The elevation and descriptor may 
have a value of 0 or None, respectively, if nothing was assigned.  These files are 
continually updated during calculations without any separate operation by the user.  The 
file data are readable only within the program or by pasting to the clipboard.  Viewing by 
other methods will produce meaningless characters.   However, this data can be 
converted into ASCII (text) format using the EXPORT command or when DXF files are 
created.  The IMPORT command converts ASCII files into the QuickCogo  format.  The 
program data files (not ASCII) may be edited only within the program.  Once a calculation 
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is completed the data is stored in the file and cannot be lost even if the computer’s power 
is interrupted.  The file is automatically saved.  F8 displays the file in use. 
 
Files from the original version of QuickCogo  or from the 32-bit version immediately 
preceding this one must be converted prior to use in this version. This results from the 
change from 10,000 points and 12 character descriptors to 100,000 points and 20 
character descriptors.  A conversion routine is included in the “Edit” menu. Conversion 
may also go the other way. 
 
Long filenames are permitted as well as the use of extensions. It is recommended but not 
mandatory that you allow all of your coordinate files to have the qcw extension for 
consistency. Assign your own extension by selecting “All Files” as the ‘type’ and 
appending the extension of your choice. This file will only appear under the “All Files” 
type when browsing for it.  Names may contain the letters A through Z (Upper and lower 
case), the numbers 0 through 9 and other special characters consistent with file naming 
conventions. Do not use “/” or “\”.   
 
OPTION BOXES 
Several of the routines have option boxes for selecting various features.  Only 1 option 
can be valid.  When you select a different option, the previous one is cleared.  You may 
clear the selected option by double clicking it.  This is useful when you need to click it 
again to activate a particular feature.  
 
POINT NUMBERS 
The data in the files are keyed to unique point numbers.  The number may be between 1 
and 99999.  Number 0 is not permitted nor is any character that isn't a numeric digit. Try 
to avoid large gaps between numbers to prevent occasional "garbage” points in ASCII 
files (which can be edited out) or in the LIST routine.  There are no valid point numbers 
that are blank or have no data.  Each point has data and consumes the same amount of 
storage space (about 45 bytes) as any other point.  The size of the coordinates or the 
length of the descriptor does not matter.   However, the amount of storage used in a file is 
based upon the highest point number.  For example, a file with only points 1 and 2 will 
take up about 90 bytes, whereas a file with only points 1 and 50 will take up about 2250 
bytes.  If you have plenty of storage, don't worry about it.  Even if you had only 1 MB of 
storage available for data files, you could still have 22 files with 1000 points in each one.   
 
The closed FIELD TRAVERSE (Angle-distance) routine has some special considerations 
for point numbering.  Those instructions are contained later in this manual and in the 
routine itself. 
 
In the Embedded routines, point numbers are entered when the cursor is in the “Point 
from” and “Point to” boxes or in input boxes during the intersection routines.  An error 
message will appear if an invalid number is entered. Consecutive point numbering is the 
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default during the bearing-distance routine.  This speeds up that routine considerably 
although a different number can be entered in the “Point to” box if desired and the 
consecutive numbering would then start from the new number.  Consecutive point 
numbering is also the default in RADIAL SURVEY and FIELD TRAVERSE. 
 
You may set a SERIES OF POINTS (up to 99) along a straight line at the same distance 
from each other during the bearing-distance routine when you enter the point number 
under “Point to” followed by a decimal and a 2 digit number.  Each bearing and distance is 
repeated for the number of times specified.  For example, if the point number entered was 
14.07 then the program would compute and display new coordinates for the next 7 
consecutive points (14 through 20), using the same bearing and distance.   
 
The highest and lowest point numbers in the file are displayed at the top of several cogo 
routines in boxes labeled LPN and HPN.  This is helpful for the times you want to assign a 
number but aren't sure what's available.  These numbers are continually updated. You 
may view these numbers and the unused point numbers in a file at any time by pressing 
F9 or selecting it in the Utilities menu. They are also displayed in the Unused box at the 
top of the Embedded routines window. 
 
New points may be entered using the INPUT routine or edited using the EDIT routine. 
 
Whenever a routine asks for entering a range of points, it means entering the first point of 
the range then a “dot:” (.) and the last point of the range.  Several of the routines also 
allow entering random points in any order. In that event, separate each point with a 
space.  The routine itself should give those instructions when activated. 
 
POINT PROTECTION 
Protection for the point numbers is built into QuickCogo.  You can not inadvertently write 
over a point number while the point protection feature is in effect.  If a point number is 
entered that has already been used, a message box will appear with a warning.  The 
existing coordinates, as well as the coordinates just calculated for that point are 
displayed.  You are given the option of overwriting or entering another number.  By 
default, point protection is ON.   It can be toggled on and off by selecting the menu item 
under Options.  A practical use for this feature is checking closures during the bearing-
distance routine.  After comparing the 2 coordinates and finding them the same or close 
enough, you can click Cancel and not have to over-write or assign a new number.   
 
COGO ROUTINES 
The following pages will describe the routines within QuickCogo .  When deemed 
necessary, a picture of the window will accompany the discussion.  After the first window 
is closed and a file selected, the menus are activated and all the routines are selected 
from them or from the button bar.  A sketch that makes the explanation clearer will also 
accompany some routines.  The routines will be discussed in an approximate alphabetical 
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order. 
 

 
 
This is the opening screen where directions for opening a file are given. Note the button 
bar below the menus.  They will remain inactive until a file is opened.  Click ‘Continue’ 
and the dialog box familiar to windows applications will be made available.  
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This is the window after a file has been selected and the ‘Cogo Routines’ menu activated. 
From this menu any of the routines listed may be chosen if not contained in the button 
bar. The next page will show the Embedded screen where Bearing-distance, intersection 
problems, inverse, etc. can be performed. 
 
  



 
 

18

 
 
This is the embedded routines window. It appears immediately after the file is selected but 
does not have to be used unless you are going to use one of its routines. You may go 
directly to another routine by selecting from the button bar.  
 
The above window shows a bearing-distance traverse with an inverse and an example of 
the point protect feature.  You will note a descriptor may also be entered. Although 
elevations are never entered during any procedure within this routine, there is also a 
provision as a way to save them in the file. The “Point from” box accepts not only the point 
from which the bearing-distance traverse is being run but also the entries for an inverse. 
In the above example, the inverse between points 38 and 6 were entered in that box as 
38.6.  They also could have been entered as 38*6.  There are 2 inverse formats, either of 
which may be selected from the Options menu.  Note the Point protect information has 
appeared because point 25 is already in the file.   Note the HPN (high point number) and 
LPN (Low point number) at the top.  This is updated as the point numbers increase. The 
OK button becomes the default as soon as an entry into the “Point to” box is made. 
Pressing Enter or clicking it will process the information. You may print the screen by 
selecting the “Print Display only” button.  Otherwise, printouts will have aligned columns.  
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You may close the routine or go to another one without closing.  When you return, the 
information will still be there.  

To further explain the Embedded routines, the following information is presented: 
 
EMBEDDED ROUTINES (Refer to the figure provided in the Parcel or Lot Closure 
discussion) 
Bearing-distance traverse:   
Enter the point from which the traverse will be run in the “Point From” box, TAB or press 
ENTER to go to the Bearing/Az box.  Note: If no point yet exists in the file for that number, 
click the OK button after entering the point.  Assign coordinates using the input boxes that 
follow and press OK to clear them.   Enter the bearing with one of the methods described 
previously and go to the DISTANCE box by pressing TAB or ENTER. Enter the distance 
with one of the methods described previously and go to the POINT TO box if the descriptor 
check box is not checked..  Enter a new point number if you are changing the one already 
there or if it is the first one.  Press ENTER to process.  Entries plus calculated results will 
be displayed in the text portion of the window. Note that the bearings are displayed as they 
would be written. TIP: To display the beginning point of your traverse on the first line, enter 
it in the “Point From” box and double click that box. Re-enter it to start your traverse. 
 
An Alternate Bearing/Azimuth-Distance Method. 
There may be times when you want to calculate coordinates without returning to the 
Embedded routine.  This is especially useful when plotting a figure using bearing-distance 
plot and wanting to insert another figure (like the outline of a building) within the larger 
boundary without drawing a line from the outer boundary to the beginning of the inside 
figure. Press Ctrl+F9 or select “Bearing/Azimuth-Distance Traverse” from the “Utilities,” 
menu. An input box will appear with a prompt to enter “Point from”, Point to”, 
“bearing/azimuth”, “distance”, each separated with a space.  After doing so, click OK and 
the calculation is made and the new point saved in the file. You will not see any other 
display so keep track of the point numbers.  The process is repeated until you click OK or 
Cancel or press Enter without data in the entry boxt. Descriptors are not available with this 
method. 
 
Inverse 
Enter the 2 points for which the inverse will be calculated in the “Point From” box, 
separated with a dot or an asterisk.  For example, to inverse between points 12 and 57, 
enter 12.57 or 12*57.  Press ENTER or click OK.  The inverse will be displayed with only 
the points and the bearing and distance between them as shown on the screen shot of the 
Embedded screen. Ctrl+H will toggle the inverse display to include the coordinates, 
elevations and descriptors for each point. Since an inverse may be needed while not in the 
embedded routine, you may also press F11, enter the 2 points and read the result in a 
message box.  If you press F12, you can inverse by coordinates if you don’t already have 
the points established.  This feature may be used while in any routine.  These 2 inverse 
features repeat themselves until canceled.  Only the bearing and distance is displayed. 
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Also see “Multiple Inverse” for inversing between several points in the same operation. 
 
WARNING: When using azimuths, point numbers can NOT be used for directions in the 
intersection solutions.  You MUST enter the azimuth as a number.  Example: In the line-
line solution enter 04730 or 047.30 and 075 for the 2 directions.  
 
Bearing-Bearing Intersection   (Line-Line) 
This routine computes the unknown distances and point of intersection of 2 lines with 
known bearings starting and ending with existing points.  Enter the point from which the 
first line starts in the POINT FROM box, and go to the BEARING/AZ box. 
Enter the first bearing in the direction of the intersection.  Do not enter a distance. It is 
optional to enter the point of intersection in the “Point To” box.  Click OK.   
An input box will display.  Enter the second bearing in the direction to the other existing 
point.  Press ENTER. 
Another input box will appear.  Enter the point of intersection (again, if entered before).  
Press ENTER. 
At the next input box, enter the point at which the 2nd line will terminate (the other known 
point).  Press ENTER. 
The solution will be displayed as though you had entered the data originally. You may use 
point numbers for bearings if applicable. 
 
Bearing-Distance Intersection   (Line-Distance)  
This routine computes the point of intersection and the unknowns of a line of known 
bearing and unknown distance with a line of unknown bearing and known distance, 
starting and ending with existing points.  It is used primarily when intersecting a line with a 
curve. 
Enter the point from which the first line starts in the POINT FROM box, go to BEARING/AZ 
box. 
Enter the known bearing.  You may optionally enter the point of intersection. Click OK. 
Enter 0 (Zero) in the input box which appears.  Press ENTER. 
A new input box appears with the Bearing-distance title.  Enter the known distance/radius. 
Press ENTER. 
Assign the point of intersection in the next input box.  Press ENTER. 
Enter the last point (usually the radius point of the curve).  Press ENTER. 
Enter whether the solution is at the closest point on the curve or farthest.  Press ENTER. 
The solution is displayed as describe in the bearing-bearing intersection. 
 
Distance-distance intersection 
This routine computes the unknown bearings for two intersecting lines when both 
distances are known.  This is used primarily when intersecting 2 curves.  The known 
distances are the radii of the curves. 
Enter the first known point.  Go to the DISTANCE box. 
Enter the first known distance.  Do not use point numbers for distances.  You may 



 
 

21

optionally enter the intersection point. Click OK. 
An input box appears.  Enter the second distance.  Press ENTER. 
Enter the point of intersection in the next input box.  Press ENTER. 
Enter the last point in the next input box.  Press ENTER. 
In the last input, enter the direction (clockwise or counter-clockwise) in which you are 
moving around the figure.  Press ENTER. 
The solution is displayed as in the preceding routines. 
 
This concludes the Embedded screen uses. 
 
ALIGNMENT (Highway) 
NOTE: This routine has not been thoroughly tested. Please report any errors or 
inconsistencies found. 
 
There are 2 phases associated with this routine, calculation and reports. They are 
found under the “Cogo Routines” menu at the top of the screen. The first one is where 
curve data calculations are made and/or edited.  The second is where several reports 
are obtained, including a listing of the alignment, setting of points and offsets and 
obtaining “stations and outs” of existing points.  After the initial curve data has been 
computed, the calculation form may remain hidden but the data thereon is used to 
generate the reports. Each segment of the alignment has a maximum of 9 curves, 
lettered A through I, (the last 5 on a separate form) and is known as a “set”.  If 
necessary, these sets may be chained together to comprise the entire alignment. The 
program assumes stationing increases from lowest to highest or proceeding “up 
station”.  
 
Curve data is calculated by knowing the existing P.I. points and coordinates, the 
degree of curve of each curve and its direction (right or left).  The P.I.’s may be 
calculated using the bearing-distance routine found under the “Embedded” routines or 
added to the file using the “Input” routine if they have been previously provided. They 
may also be “imported” from a prior calculation using the import routine.  
 
1. Open a new file.  Either input the P.I. points or calculate them as explained above. 
2. Open the first form of the “Alignment” routine under the “Cogo Routines” menu. 
3. Enter the beginning point number and station. Set number of decimals (3 is the 

default). 
4. Enter a name for your “set” in the “Alignment File” box at the top of the screen.  It is 

convenient to name it by number, like “set1” or some designation that will define the 
alignment.  This is the file that will generate the string of points denoting the 
alignment…e.g. 118,335950.56,*167,166,168,etc. (* indicates that point is the 
radius point of the curve). 
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5. As you type the name in (4), “set1.aln” will appear in the “Data File” space. This is 
the file that will collect your curve information if it needs to be restored.  It is also 
used in report calculations. 

6. For each curve, enter the P.I., next P.I., direction of curve (the box to the right of 
“deg of curve”), degree of curve, point numbers to be assigned for PC, PT and RP 
(radius point).  The last curve may not have a forward P.I. so enter any point on the 
forward tangent, even the PT for the next P.I. If there are more than 4 curves, add 
more by selecting the “Additional curve” button, then ‘Return’ when completed. 

7. Click “Compute Curve Data” button and the remainder of the curve information will 
be displayed, together with the station at each PC and PT. 

 
After the curve data has been computed, you are ready to calculate stations and 
offsets.  You will not have to return to this screen unless you must edit or restore the 
curve data or begin a new alignment.  You may view the curve results at any time by 
selecting this routine from the ‘File’ menu.  During the course of the curve 
computations, a new file named “set1.qcw” (or the one you use) was created and 
should now be used for this alignment.  It is the coordinate file. 
 
REPORTS 
You may now go directly to the next routine or at anytime after the above calculations 
were made. Let’s assume you are doing this at a later time. 
1. Open “set1.qcw” when you start the program. 
2. Select “Alignment Reports” from the “Cogo Routines” menu. You do not have to re-

calculate the curves. 
3. Enter “set1” as the name of file to be retrieved.  Set number of decimals (3 is the 

default). 
4. Click OK.  The beginning point and station will be displayed, together with the string 

of points defining the alignment. 
5. Select an option.  “Alignment listing” will display the stations with their points and 

coordinates,  “Set points and offsets” will display a new frame with entry boxes to 
compute coordinates for offsets at a specific station (assign point numbers) and 
“Station and outs” will bring up an input box where you enter the point number (must 
exist in the file) for which the station and out (distance, right or left of the base line) 
will be calculated.  This input box will continue to be displayed after each calculation 
until you cancel it by clicking OK with nothing entered or clicking Cancel. 

6. The results of the calculations of each of these options will be displayed in the large 
text box in the upper right portion of the screen. 

7. You may print a hard copy of these results by clicking the “Print” button. 
 
NOTES:  
The display box may not align the results in a straight column but they will appear so in 
the hard copy (except for the stations and offsets) 
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You may have to turn “Point Protect” off (from the ‘Options’ menu) prior to restoring a 
file either in the Alignment calculation routine or the “Reports” routine.  It will save time 
rather than overwriting each point but it will assure the points are the correct ones.  I 
recommend disabling it. 
 
 
ANGLES  (Choose from the Utilities menu) 
This routine allows you to calculate the angles formed by the intersection of 2 lines with 
known bearings or azimuths.  The bearings or azimuths must be entered as going from the 
intersection point.  Simply enter the bearings in the boxes, click OK or press ENTER and 
view the results. An entry box has been provided for entering the bearings as point 
numbers, with the angle point as the middle number, each separated with a dot.  
 
 
 
AREA See next page. 
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AREA  (Select from Cogo routines or button bar) 
Above is the window showing area calculations. The long box is the one in which the 
points defining the figure are entered.  Each must be separated with a space.  The last 
point entered must be the same as the first in order to close the figure.  A space must be 
entered after the last point entry.  You can clear the entries and compute another area or 
just change point numbers to get a new area.  This is helpful when you are using the trial 
and error method or have several areas to calculate which have common points.  The 
large text box displays the courses between the points entered.  The area in square feet 
and acres is displayed in separate boxes.  The example above points out how it works, 
including a reverse curve.  Points 1, 2 and 3 are separated with a space.  Point 3 is the 
first point of a curve, point 5 is the next point on the curve and point 4 is the radius point of 
the curve. Note that point 5 is entered as a negative, then the letter R or r  (without a 
space) and point 4.  This grouping defines the curve.  The next curve is left so the radius 
point is entered as a negative.  A space is then provided prior to the next point, 8, etc. and 
point 1 again to close the figure, followed by another space.  When ENTER is pressed, or 
OK is clicked, the display screen shows the actual courses and curve information for the 
figure.  When curves are part of the figure, you must go clockwise. .  The curve information 
now displays “Radial In” and “Radial Out”, representing the bearings from the PC to the 
radius point and back to the PT.  Number of decimal places may be selected for display. 
You may also group consecutive points to save keystrokes.  If you had a 10 point figure 
with no curves, you could enter the points: 1 2.10 1.  This computes the area from 1 to 2 
and then from 2 through 10 consecutively and back to 1.  The first point must be entered 
alone.  If curves were part of the figure, you could still use this method, but would stop at 
the curve first and then continue.  There is a metric option for distance and area.  
 
This routine may also be used as a map check so that coordinates and closure information 
are displayed.  A check box (not shown in the above screen shot) will activate that feature 
when checked.  In order for the closure to be computed, a point representing the 
theoretical closing point must be used as part of the string of numbers and appear before 
the first point at the end of the string.  This is done automatically after the original area 
points are entered and executed.  An input box will appear for you to enter the closing 
course of the figure (bearing and distance back to the beginning). It calculates the closing 
point as “point 99” and inserts it into the number string before the first point.  For example, 
if you were closing a 5 sided figure using points 1 through 5 your string would look like this 
before you clicked OK (1 2 3 4 5 1) and like this after you clicked OK and entered the 
closing course (1 2 3 4 5 99 1). As you know, an exact closure is very rare although the 
area routine forces a closure back to its beginning point using the existing points in the file. 
In our example, the error of closure is the difference between points 99 and 1.  Regardless 
of the error the area is computed as though the parcel closes with the last leg of 99 to 1. 
TIP: You may display the coordinates of the first point by double clicking in the long box. 
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PRE-DETERMINED AREA... (Check box near upper right) 
This routine is toggled on and off by checking the box labeled "Pre-determined".  It has 2 
options, called "Sliding" and one named "Pivot".  The 2 sketches within the frame define 
how it works. When a line is to be entered, do it with point numbers, separated with a 
space. When a bearing is to be entered, do it with the QuickCogo format. The coding was 
done in the order of the sketch's point numbers, so try to orient and enter you data 
likewise. The point numbers, of course, are arbitrary. Upon completion, the results of the 
computed distances are displayed beneath the entry boxes and the coordinates are stored 
in the file. You may check the area by toggling the frame off and entering the numbers 
normally in the main screen. These numbers will remain although you reset the pre-
determined entries. This saves you from re-entering each time if want to try various areas 
for the same configuration. 
 
AZIMUTHS 
These have previously been discussed in detail.  The default for QuickCogo  is bearings.  
North or South azimuths may be toggled On/Off from the Options menu.  
 
MULTIPLE INVERSE 
This routine is activated from the Cogo Routines menu or Ctrl+F11.  It computes and 
displays the inverses between a range of points (separated with a dot) or random points 
(separated with a space).  You may go in either ascending or descending order.  As 
discussed previously,  Ctrl+H will also displacy coordinates, elevations and descriptors. 
When inversing in descending order, the first point will inverse to itself before proceeding.  
 
BEARING STORAGE AND LISTING 
This routine permits you to store up to 99 bearings or list those already stored.  It is 
activated from the Utilities menu.  The window is self-explanatory.  Select "store" or "list" 
and enter the bearing in the box.  It is entered as you would enter it within the program. 
You can enter it as 7 digits or point numbers.  Assign a number to the bearing.  This is the 
number that you will enter when the bearing is called for in the embedded routines.  A file 
with the extension ".bg" will be created containing the storage information. 
 
CLEAR BUTTON  
Many of the routines have their own Clear or Reset button, either for display, entries or 
both.  
 
CARDINAL BEARINGS 
Cardinal bearings are North, South, East and West.  Select it from the Utilities menu.  The 
cardinal bearings are now stored as follows: 1=North  2=East  3=South  4= West.  You can 
now enter a cardinal bearing by entering only 1 digit rather than 7.  Once activated, it can 
not be turned off. 
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CONVERTING FILES 
This routine converts the data from and to previous QuickCogo  versions.  Since the 
newest version allows 100,000 points and 20 character descriptors vs 10,000 and 12, the 
files are not interchangeable without converting first.  Old refers to previous versions and 
New to the most recent.  Files from the Dos QC2 (Dos) version cannot be converted. 
 
COPY POINTS BETWEEN FILES 
This routine allows you to copy points from one file to another.  It is activated through the 
Edit menu. The window is self-explanatory.  This routine has several uses.  You can 
customize a file by deleting some points and adding others.  Suppose you only wanted to 
rotate or translate a portion of a file.  You could copy those points not affected to a dummy 
file, delete them from the main file and copy them back from the dummy file after the 
routine is completed.  You may enter a range of points by separating the values with a dot 
or random points separated with a space.  Point protection is disabled during this process.  
 
 
CURVE CALCULATIONS 
This routine allows you to compute the unknown data for any curve, whether it is in the 
active file or not.  Activate the routine through the button bar or cogo routines menu.  The 
menu has a sub menu from which several options may be selected.  Refer to the following 
picture of the window. 
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Enter any 2 known points on the curve and the remainder will be computed and displayed 
in the boxes shown.  Enter the delta as any other angle, 1, 2 or 3 digits for degrees and 2 
digits each for minutes and seconds.  In the example above, a radius of 200 and a tangent 
of 50 were entered.  Tenths of seconds for the delta may be entered. This data can then 
be printed. Curve traverse is explained on the routine’s window. 
 
There are also other curve routines, namely CURVE INVERSE which computes the curve 
information between 2 existing points in the file, finding the radius point when 3 known 
points on the curve’s arc are known, layout of a curve in segments (used for staking), road 
curves where the data is computed for a street given the P.I. and bearings each way, spiral 
and vertical curves. The next several pages will display the screens and diagrams 
associated with these curves. 
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CURVE LAYOUT 
 
This routine provides the means to divide curves already in the file into equal or arbitrary 
parts for field layout or mapping purposes.  Points must exist for the PC, PT and center of 
the curve.  This routine is accessed through the Cogo routines menu. The explanation 
below, the figure above and the screen on a following page should provide an 
understanding of this routine. 
 
Referring to the figure, you will note a dotted reference line in the middle of the 2 curves. 
This line could be a centerline, a survey line or any other line that can be used as a basis 
for layout.  It can even be the line to be laid out.  It is shown in the center for illustration 
only.  In the example, the reference line curve has been established with point 10 as the 
center, 11 as the PC and 12 as the PT.  The other points shown are to be computed.  The 
data must be entered so that the curve is to the RIGHT.  The points created are along the 
"staking line".  All entered data is along the "reference" line.  In this example, the curve will 
be divided into 4 equal parts.  The reference line and "staking radius" lines are the same.  
The reference line radius is internally calculated from previous data.  It is displayed so that 
you can easily enter the staking radius without looking for it from other sources.  The 
staking radius is the one for which you want the points calculated.  It is computed by 
adding or subtracting the desired offset to the radius of the reference line.  When the 2 
values are the same, as they are in this example, the curve data will be figured for the 
reference line.  The points 20, 21 and 22 will then be computed and placed in the file.  
These are only 3 points although we wanted the curve divided into 4.  Since points 11 and 
12 are already in the file, there would be no reason for having 2 points the same.  
However, had we chosen to use a line other than the reference line, 5 new points would 
have been calculated so that the new PC and PT on the offset would be included.  
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Suppose that 320.00 were the staking radius and point 30 was the next available point.  30 
would be the new PC, point 34 the new PT with the other 3 points between.  Duplicate 
points are shown to illustrate an offset in either direction.  The number sequences shown 
in the example are arbitrary and have been separated for illustration only.   
 
 

 
 
Stations will be used for the next example, although there is not an accompanying sample 
window. Points 11 and 12 are again the PC and PT, respectively, but, rather than the 
Equal Option being chosen, choose Stations.  Stations are entered without the + sign, so if 
we use station 2+30.00, it is entered as 230.00.  Point 40 is the next available point and 
we'll use Constant stationing at a fixed arc distance.  This means that points along the 
curve will be calculated according to fixed constants along the curve.  Suppose that 50 feet 
is the constant distance between points on the arc and that we wanted to begin at station 
2+51.35.  We would enter 251.35 in the Station box under CONSTANT or 21.35 in the 
Distance box.  Enter 50.00 in the Arc Distance box.  Since the remaining arc length of the 
curve is not equally divisible by 50, a remnant of 26.66 is left. (There are an infinite 
number of variations with this example).  Again we would enter a staking radius.  The 
points 40 through 46 would be calculated and placed in the file.  Had we chosen the 



 
 

30

Arbitrary option, the points along the curve would have been calculated separately each 
time we entered a new arc distance .   
 
CURVE DIVISION  
A similar routine to the one described above is found under “Cogo Routines” as “Divide a 
Curve”. The instructions are on the routine itself and are self-explanatory.  The curve must 
exist. You can begin anywhere on the curve so long as it is an existing point. You can then 
divide the curve or remainder thereof by equal parts, by arc length or by delta angle and 
obtain coordinates for the resulting points. 
 
CURVE INVERSE 
Obtains the curve data for 2 known points on a curve when entered clockwise. First point 
is the pc or poc, then the next poc, then the radius point.  The second point may also be a 
target point for calculating its station when the station of the first point is known. Separate 
entry boxes are provided.  Stations of points not on the curve may also be calculated as 
they relate to the curve stationing itself by computing a temporary point on the curve with a 
line from the radius point through the off-curve point stopping at the curve. Use the 
Embedded routines for this calculation. Assign the temporary point a number greater than 
the off-curve point by a constant.  For example, if the off-curve point is 25, assign it 1025 
(1000 more) and add 1000 to other similar points for which you want the station.  Then, 
when the calculation is made, subtract that constant by entering it in the ‘pt constant’ box 
and checking ‘use constant’.  The display will then show only the off-curve point and its 
station. 
 
CURVE THROUGH 3 POINTS 
This routine computes a curve defined by 3 points on its arc.  The 3 points must be 
entered in a CLOCKWISE direction only and are separated with dots in the data entry box. 
If, for example, you had tied 3 points on a curving railroad track or curb, etc. while you 
were in the field, you could now write a description that would include the curve definition. 
The other entry is to assign a point number for the radius point of the curve.  After the 
calculation is made, the radius is computed and displayed.  Using this information, all other 
curve data may be found using the Curve calculation routine. 
 
CURVES, ROAD ALIGNMENT 
This routine computes the right of way curves for a road or street, given the P.I., the 
bearings ahead and back and either the semi-tangent or centerline radius.  It may be used 
during subdivision calculations when the P.I. of a proposed street has been established 
and you want to put curves on both sides.  Access the routine through the curves item in 
the Cogo routines or Alpha menu.  Refer to the figure on the next page. 
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Referring to the figure above, assume that point 10 is the P.I. from another routine and 
points 6 and 18 are points on the lines forming the intersection.  You want to compute the 
coordinates and curve information for the right of way curves.  On the next page is a 
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picture of the screen as it would appear after the information is input and calculated.  You'll 
note that the ahead and back bearings may be input as any bearing can.  Either the 
tangent or the radius can be entered, not both.  When you make an entry in one of them, 
the other is disabled.  If you make an entry in the wrong box, backspace to clear that entry 
and double click in that box.  Both boxes will then be enabled.  Curve data is displayed for 
the centerline and for both sides of the right of way.  The points calculated are now in the 
file and assigned as shown in the Points box.     
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CURVES, SPIRALS 
There are 2 different routines for spirals.  The first one is a shorter version that computes 
the length along the tangent and the perpendicular offset to the spiral.  This permits users 
to determine for themselves how to proceed with the information displayed.  Some may 
want to stake the spiral by giving offsets along the tangent while others may choose to 
calculate angles from the beginning of the spiral to each of the points.  No coordinates are 
assigned to points in the short routine.  Access this routine through the same means as 
other curve routines. 
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In this example, chord spiral was selected.  As a result, the incremental length and curve 
radius boxes were disabled.  Otherwise, you would have put an arbitrary length of spiral in 
one box and the radius in the other and the result would have been displayed.  We used 
10 chords in a spiral length of 140 feet.  The radius of 520.87 was entered in the entry box, 
ENTER was pressed and the x and y distances along the tangent were calculated and 
displayed.  Each tangent distance is about 14 feet longer than the previous one, since we 
used 10 chords in 140 feet. 
 
The LONG SPIRAL routine will compute the coordinates for the points shown in the figure 
on the preceding page.  Enter the points in their appropriate boxes as shown in the 
example on the next page and press ENTER. The points will be stored in the file.  Angles 
must be entered as 7 digits. 
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CURVES, VERTICAL   (Figure and window on following page) 
This routine computes the elevation for any point on a vertical curve when the required 
control data is given.  Select this routine from the Curves menu.  The example figure and 
window on the following page display a "summit" vertical curve with an elevation of 
4523.00 at the PVI station 6+00.  Stations are entered without the + sign.  Enter the station 
for which you need an elevation in the Station? box at the end of the row.  Slopes are 
entered as a percentage (%). For example, a slope grade back of 4.5 means the slope 
changes 4.5 feet every 100 feet. You may also enter the slope as ‘feet per foot’ by 
checking the applicable box.  In this case, the slope grade in the previous example would 
be entered as .045.  The column of boxes on the left displays the basic information about 
the curve itself and the other box displays the station results.  You may continue to enter 
stations or change any of the other data entry boxes and press ENTER or click OK to 
change the displays.  If you want consistent incremental stations enter the increment in the 
appropriate box. The station of the high or low point is also displayed depending on 
whether Summit or Sag was selected. These may be chosen by Alt+Underlined letter in the 
title or by clicking one of them and then tabbing to the first data entry box. A summit 
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vertical curve is defined for this routine when the elevation of the vertical curve at the PVI 
station is lower than the PVI regardless of whether both slopes are going in the same 
direction. A sag vertical curve is when the elevation is higher than the PVI.  You may also 
create a text file for saving the vertical curve entries and re-running it at a later time.  It is 
similar to the “Data Entry Files” created for other routines. The buttons Make File and Run 
File are not shown here. 
 
 
  
 
 
There is also a provision for finding the station where a particular elevation falls on the 
curve.  This is done after the initial calculations have been made and displayed for the 
curve.  Enter the elevation and click “Calculate”. The entered elevation and calculated 
station will be shown in the display box.  In some cases the elevation will be found in 2 
places on the curve, both of which are displayed. 
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CUL-DE-SAC  (No diagram available) 
This routine calculates the necessary points for the centerline and street line PC's and 
curve centers of a symmetrical cul-de-sac.  Refer to the following window. The information 
requested is depicted in the column of data entry boxes.  All of the boxes must contain 
data before execution.  Enter the bearing of the road as you would any other bearing but 
go in the direction AWAY from the center of the cul-de-sac toward the transition curves. If 
there are no transition curves, enter 0.  There will be 7 new points created as follows: 
Assume you are at the center of the cul-de-sac looking in the direction already noted.  
Using the sample entries in the next window, 
Point 30 is a point on the centerline opposite the PC's of the transition curves or opposite 
the curve intersection with the street lines if there is no transition curve. 
Point 31 is the point 25 feet (half width of road) perpendicular to the right of point 30. 
Point 32 is the center of the 15 foot radius transition curve on the right. 
Point 33 is the point of reverse curve of the 15 and 50 foot curves on the right. 
Point 34 is the point of reverse curve on the left. 
Point 35 is the center of the transition curve on the left. 
Point 36 is the point 25 feet perpendicular to the left of point 30. 
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These points are not displayed but are now stored in the file. 

 
 
Data Entry Files 
These files are created for the purpose of making permanent records of data entered for 
various routines ( bearing-distance, angle-distance, map check, radial and lotplot).  There 
is also one for Interactive Plot but it is accessed from the routine itself. After recording the 
data, it can be edited, if necessary, and then “played back” for new results. A file is made 
by selecting from the top menu and giving it a name. If this feature is used frequently, it is 
suggested that the files be named with different extensions to keep them separated. For 
example, a bearing-distance traverse file might have the extension of "bdt", the angle-
distance traverse "adt" and the map check "mct". Then run the routine as normal. Your 
entries will be recorded as you enter them in the text file you made. When completed, the 
file is saved in the current folder. Although there is an on-board editor especially for these 
types of files, they can also be created and edited outside of the program with a text editor. 
To re-run the file, select "Run File" for the applicable routine under the same “Data Entry 
Files” menu or edit it first by selecting "Edit File". These files can even be used for plotting 
within the subject routine if that routine has a plotting feature. A file is created 
automatically when plotting the bearing-distance, angle-distance or radial routines.  
Experiment to become familiar with its operation. IMPORTANT: The file must be created 
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BEFORE the actual routine is run.  A provision to edit the files within Notepad has been 
added.  After the name of file has been entered, the next screen shows the file in its 
columnar format. There is a check box on this screen, which when checked, will allow you 
to call up the file in Notepad and do your editing. Notepad is more flexible than the edit 
window within the routine.  You will have to open the file manually by selecting File, 
Open…but the list of files that appear are within the default folder with the default 
extension of “.txt”.  You can change the “Files of Type” box to show “all files” if yours 
doesn’t use the txt extension.  If you will be using Notepad frequently, it would be a good 
idea to add the txt extension to your data entry files.  A provision has been made to turn off 
point protection when “playing back” the files if they have not been edited since the last 
time they were run. This will prevent the interruption from the point protect feature at each 
point. 
 
DECIMAL PLACES 
Many routines contain a drop-down box to set the number of decimal places for distances 
and coordinates.  The values are between 0 - 5, the initial default being 3. You may set a 
new default through the ‘Options’ menu or by changing the value within a routine.  After 
clicking OK for the calculation, all subsequent routines will use that decimal places value 
until it is changed again. 
 
DELETE POINTS 
This routine permits you to delete selected points in a file.  Select this routine from the Edit 
menu. The window is very simple.  Just enter a single point, a range of points (separated 
with a dot) or random points (separated with a space).  A notice of completion is displayed. 
 
DIFFERENCE BETWEEN COORDINATES 
This routine allows you to display the North-South and East-West differences between 
coordinates.  Select “Compare Points” from the Utilities menu. Simply enter the points for 
which you want the differences in the applicable box, press ENTER or click OK and the 
results will be displayed.  You must separate the point numbers with a dot. 
 
 
DXF (D)rawing E(x)change (F)ormat routine converts a QuickCogo  file into a file that may 
be transferred into a CAD program like AutoCAD or some other Cad software that accepts 
DXF.  The file created is in text format that can be viewed, edited, etc.  Access the routine 
from the Utilities menu or button bar.  There are 4 separate options for creating the file. 
They are listed on the window below, the first of which is "Points only".  After entering the 
file name and range of points to be converted, select an option.  The conversion will be 
made and a message will appear informing you of its successful completion. 
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Upon completion, you would then be able to view the points, represented by a small circle, 
in their proper relationship to each other, the center of the circle representing the exact 
location of the point and being the “snap on” point.  Each point would have the 
accompanying text, such as its point number, elevation and descriptor displayed by it.  In 
the Cad program, you would then be able to join the points with lines, curves, etc. to 
produce a map.  The accompanying text is on individual layers so that each layer may be 
turned on or off as permitted by your Cad software.  Formats 1-4 have a circle on Layer 
253 and text for the point number on layer 254.  Format 2 also has a circle and text for the 
descriptor on layer 255.  Format 3 also has a circle and text for the elevation on layer 255. 
 Format 4 also has a circle and text for the descriptor on layer 252 and a circle and text for 
the elevation on layer 255.  Text is displayed at a 45° angle to the small circle representing 
the point. This routine also permits transferring drawings to a cad program. Points, lines 
and their bearings and distances are exported, each on their separate layer. The 3 
routines for which this new feature works are Map Check, LotPlot and Interactive Plot.  
Each of these routines has an option button or check box that must be selected to make 
the exporting of the drawing possible. You may also create a coordinate file independently 
using the export routine or customize one of your own in a text editor. However, the export 
method will create a coordinate file that will join lines between points in the order they 
appear in the file. Some editing may have to be done.  However, you could run a bearing-
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distance or angle-distance traverse in the order you wanted to make the drawing, export 
the file and make the dxf. The DXF window has an option, marked in blue, which, when 
selected, causes another text box to appear in which is entered the name of the 
point/coordinate text file previously created in one of the 3 routines mentioned.  Generally, 
the height of text should be increased from 1.8 to about 4, depending upon the size of 
drawing. Some experimentation may be necessary.  When you click “Make Dwg DXF” the 
dxf file will be created for use in your cad program.  I have successfully tested it in 
AutoCad LT. The bearings and distances along the lines may have to be manipulated to 
place them properly but that is fairly routine for anyone familiar with cad. It is feasible that 
a subdivision or ALTA survey map could be created prior to transferring to the cad 
program.  
 
EDIT DATA FILE  
The data in a file may be changed, added to or deleted from.  The routine is selected from 
the Edit menu. Enter the point number in the appropriate box press ENTER or click OK and 
the existing data will appear in their boxes.  Make the changes, click the Save button and 
make other changes or Exit. 
 
EXIT PROGRAM 
Exit the program by selecting exit from the File menu, from the button bar or clicking the x 
in the upper right corner. Individual routines are exited by clicking the Close button. 
 
EXPORT 
This routine permits you to convert a QuickCogo  file into a readable text file (ASCII) in 
several formats.  This file can then be processed into a data collector or a Cad program 
that can read ASCII files (other than Dxf).  There are 8 formats used.  This routine is 
accessed  from the File, Utilities, Alpha menus or the button bar.   You must use the 
Browse or Open buttons to enter the names of the source file.  Click the Ascii file box and 
the same name with an extension of “.txt” will automatically be inserted.  You may edit this 
name if desired.  Choose the format, keeping in mind that most Cad programs accept data 
with the east coordinate listed first. As soon as you select the format, the routine is 
executed and a notice of completion is displayed. Export also allows exporting groups of 
points and changing from feet to meters and vice-versa.  You may also select exporting the 
file as “space” delimited as well as “comma” delimited, the default. 
 
 
FIELD TRAVERSE  (Angle-Distance Traverse) (See following pages for example and 
window) 
This routine is designed to create points from data obtained in the field during an angle-
distance traverse.  If using azimuths, zero the instrument on the backsight at each setup, 
then record the angle. The display will be the resulting azimuth based upon the azimuth of 
the first setup and backsight. The traverse may be open or closed.  At the end of a closed 
traverse the angles may be adjusted and the compass rule applied to complete the 
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closure.  This routine is accessed from the Cogo Routines or Alpha menus. The next figure 
is a sample traverse.  The following discussion and sample window will explain how it 
works. 
 

                                                  
 
 
 
 
 
 
 
 
 
 
 
 

13
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                                         ANGLE-DISTANCE TRAVERSE 
 
The above figure represents a sample traverse.  Assume we begin at point 1 with 
coordinates of N 1000, E 1000 and sight point 2.  These 2 points must exist in the 
file or if you knew the bearing of the line being s ighted, then you could create a 
point on that line using the bearing-distance routi ne OR you could assume a 
bearing and rotate it later.   There is no provision for entering ONLY a bearing o r 
azimuth. You need 2 points with coordinates.  We go around the traverse, turning 
angles right and measuring the distances (horizontal or slope).  Each point is 
automatically numbered with the next higher consecutive number (maintain this plan for 
closed traverses).   Begin by selecting "Closed" traverse.  A label with a light blue 
background will appear informing you to enter the word "Close" (in the angle box) after 
the last course (click the label and the word will be inserted for you).  Enter the point 
occupied, which is point 1, point sighted which is point 2.  Now enter the ending point of 
the traverse, which in this case is point 1 again.  It could also be another existing point 
with known coordinates.  Enter the point to which the closing angle will be turned, in 
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this case point 2, enter the elevation of the point occupied and the other items related 
to elevations, like height of instrument
and height of reflector.  The cursor then will go to the angle box.  Enter the angle right 
or left (with a - sign) and the distance to the next point.  The next point box will 
automatically increment as you proceed.  After the last leg of the traverse enter a point 
as usual, although theoretically it is the same point.  In our case points 13 and 1 
theoretically should have the same coordinates if the traverse closed exactly, but 
probably won't.  Point 13 must be entered so that the routine can compute the closing 
information.  Pressing ENTER after each set of angles and distances, will produce the 
actual bearings, distances and coordinates and display them on the screen below the 
data entry boxes as shown in the window above.  After the last leg of the traverse has 
been entered, enter the word "Close" in the angle entry box and click OK.  This triggers 
a pop up box requiring input of the closing angle.  A message box then displays the 
closure data and the angular error, if any.  Generally, the angle closure should have 
been checked in the field after completing the traverse.  The following boxes include 
input for whether or not to adjust the angles, another message giving the new closure 
data and whether or not to adjust the distance error.  Each has a default answer. If you 
have forced an angle closure and the distance error is minimal, I recommend not 
applying a correction for distances in order to preserve the bearing or azimuth of each 
course.   
 
The open traverse works the same except that there is no closing point.  Each method 
has a Sideshot provision. Enter the letter "S" prior to the value of the bearing and the 
next calculation is a sideshot.   Choose the point number to be well out of the loop of 
the main traverse.  If it is included in the main traverse, the closure calculations will be 
inaccurate.  Be sure to change the point occupied and point sighted after each side 
shot and before going back to the main traverse.  You will note that these points 
change as you move to the next point in the traverse.  You can check the closure by 
inversing between the beginning point and the last point you entered.  It should be very 
close to 0.000. You may also edit your entries if you find you made a mistake along the 
way.  Click Reset then begin alternating between Edit and OK. You may also display 
your angle entries by checking the box. You also may check the closure from one 
known point to another without having a closing angle.  Use the “Closed” option and 
begin as before with a point occupied and a point sighted. Enter the “End” point and a 0 
(Zero) for the “Closing angle point”.  Proceed around the traverse as before and enter 
the last point, theoretically at the same location as the End point, but, practically, only 
in close proximity.  Use the next consecutive point number for this last point. Insure that 
the point numbers along your traverse are consecutive and don’t include any existing 
points.  For example: Say the point from which you want to begin the traverse is point 
6, the point sighted is 7 and the point to be closed upon is 25. There are 8 traverse 
points. You could use points 15 through 22 or other combinations so long as they met 
the above criteria. Then enter “close” in the angle box as before after which you can 
choose to close by the compass rule. The closure information will be shown.  You will 
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be given the option of accepting the closure or, if the closure is too far off, checking the 
field data again.  Answer the prompts until a closure is complete.  If you don’t enter a 0 
for the closing angle point, you will be prompted for a closing angle as before.  Enter 
any angle and proceed as though you were using a closing angle except answer ‘no’ to 
adjust the angle closure error and ‘yes’ to adjust the distances. The results will be the 
same as though you had entered 0 for the closing angle. 
 
Azimuths can be used in 2 ways. If they are only chosen in the “Options” menu, then 
you will have to “zero” at each setup and turn an angle. The resulting azimuth is the 
previous one plus or minus the angle. The other way is to check the “Carry Azimuth” 
box and enter the actual azimuths rather than angles.  
 
GPS (Latitude and Longitude Traverse) 
This routine calculates new values for the latitude and longitude for points on a traverse 
from a point with known latitude and longitude coordinates. It is primarily for those using 
handheld GPS receivers who want to locate the approximate position of a point on the 
ground relative to a known point.  A text file (mandatory) is also created to store the results 
of the calculations, including the coordinates and the lat/long of each traverse point. The 
routine’s window is self-explanatory.  Access from the “Cogo Routines” menu.  
 
GRADES 
This routine calculates and displays the finished elevations at user defined stations at 
regular or random intervals.  This routine is accessed by selecting from the Cogo Routines. 
Enter stations without the + sign.  The sample window below shows how it would look from 
station 250 to station 400 at 25 foot intervals on a –2.36 slope.  Stations less than the 
beginning station would have a lesser elevation than the beginning one and those greater 
than would have a higher elevation.  Negative grades may be used. 
 
There is also a provision for finding the station when an elevation is entered.  This is done 
after the initial calculations are made and displayed.  Enter the elevation for which the 
station is desired and click “Calculate”.  The new data is shown in the display box.  The 
station may exceed the last station or be less than the beginning station. 
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IMPORT DATA 
This routine allows you to bring an ASCII file into QuickCogo .  The routine converts the 
data into a compatible format for the program.  You must enter the import file using either 
the Browse or Open buttons.  Then click the QuickCogo  file box and the same name with 
an extension of  “.qcw” will be automatically inserted but it may be changed.  Select the 
format.  You must select the format that contains the same number of elements as in the 
file to be imported.  The elements in the source file must be separated with commas only if 
the descriptors (if any) contain spaces.  
 
INPUT DATA 
This routine permits you to enter new data into the file.  It is not to be used to edit data. 
You may access this routine through Input on the button bar. Point protection will prevent 
writing data over an existing point. 
 
INTERSECTIONS 
The figures and windows on the following pages will assist in the discussion of the 
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calculation of street intersections, both curved and tangent.  Both are accessed by 
selecting Intersections, Curved or Straight from the Cogo Routines menu. 
 
                     

                        
 
The above figure shows an intersection of tangent lines connected by small curves.  This 
represents an intersection of 2 streets.  The routine will compute the coordinates at the 
points shown.  Point 25 is a known point, with the through and intersecting streets having 
known bearings.  Although the figure shows a cross intersection, it should be considered 
as a "T" intersection which could be computed twice, once for each side.  In this example 
the top side of the intersection will be computed.  The bearing of the intersecting street is 
entered as going away from the point of intersection or as 1183000 or according to bearing 
entry conventions described before.   
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The bearing of the through street is entered as being Clockwise from the intersection.  In 
other words, standing at the center of the intersection, looking away from it and turning 
clockwise.  This bearing would then be entered as 1700000 or according to bearing entry 
conventions described before.  The boxes for the width of the respective streets appear 
below the boxes for the bearings for those streets.  The radius is for the small connecting 
curve (Both curves must have the same radius).  The next available point should be one 
that is within 12 points of any existing point in the file or the point protection comes into 
play and you will have to overwrite or renumber.  After completion, a message appears at 
the bottom of the screen informing you that the points are now in the file.  
 
The Curved Street Intersection is very similar. The figure on the following page represents 
a sample problem using this routine.  In this example, we will compute the lower part of the 
intersection.  Point 25 is the centerline intersection point.  We must determine whether the 
street intersects the inside arc (with the smaller radius) or the outside arc (with the larger 
radius).  Select one of the options before entering data in the other boxes.  The bearing of 
the intersecting street is always entered as going from the larger radius to the smaller 
radius.  We could enter the intersecting street bearing as 2060000 or according to bearing 



 
 

49

entry conventions described before, EXCEPT do not use point numbers.  We do not have 
to enter the through street bearing since it would already be known from the existing curve 
data.  The intersecting street width, the radius of the connecting curve, if any, the radius of 
the street line being intersected, the point number for the center of curve and the next point 
to be assigned must be entered.  Press ENTER or click OK and the calculations will be 
made.  Other data you might need may be computed using other QuickCogo routines. 
 

 
                                                         CURVED STREET INTERSECTION 
 
LATITUDE/LONGITUDE POINTS  FOR PLOTS  AND DISTANCES BETWEEN 
This routine was designed for a user who wished to obtain and plot GPS points of good 
fishing spots so that he could find them again when returning to the same area.  Of course, 
the routine can be adapted to other uses as well.  It is found under the ‘Cogo Routines’ 
menu.  You should open a new file if the active one is not the one to be used for the 
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routine.  Enter a point number and the latitude and longitude for that point. After clicking 
OK, the point will plot in the display box and the cursor will return for another point.  Each 
point has a coordinate derived from the beginning latitude and longitude.  The coordinates 
are very large numbers related to the distance in feet from the equator and prime meridian. 
The northings may be positive or negative depending upon the latitude and longitude.  
Upon completion, you can list the points or plot them using the ‘Iplot’ routine or go to the 
DXF routine and create a file for a Cad program.  If, after completion, you want to 
transform the coordinates into another datum, go to the ‘Translate’ routine by clicking the 
marked button. 
 
The latitudes and longitudes may be entered in one of 2 methods: 
 1.  43 02 14    -87 34 17         Degrees, Minutes, Seconds 
 2.  -43 02.233  -87 34.283       Degrees, Minutes, decimals of minutes 
 
Click the ‘Print’ button to print the results of the calculations. 
 
You may also compute the distance between any 2 points defined by their latitude and 
longitude.  The distance is along the great circle (earth’s curvature).  Enter the points 
and their lats and longs, click ‘Find’ and the distance in miles and kilometers will be 
displayed.  This is intended for longer distances.  For shorter ones, you may find the 
bearing and distance by inversing between their cartesian coordinates using the above 
method.   
 
LATITUDE/LONGITUDE CONVERSIONS  (Optional Utility) 
This is not a QuickCogo  routine but has been included as a utility accessed through the 
“Utilities” menu.  It is a free government program named “Corpscon6” that converts to and 
from various coordinate bases like geographic, state plane, U.T.M., etc.  If you received 
the program on CD, it is included on that disk as corpscon_complete.exe .  You may 
install from there or copy it to your hard drive and double click.  It will install the program in 
“C:\Program Folders\corpscon6”.  If you received the program via download, a link to the 
web site where it can be downloaded is included.  However, it is a 104 MB download and 
not recommended for anything other than a high speed connection. In that case, you may 
want to consider receiving QuickCogo  on a CD or having one mailed separately for a 
$5.00 charge.  A help feature within the Corpscon explains its operation, although you will 
have to have Adobe Acrobat to read the PDF file.  Most users will probably want to convert 
between lat/long to state plane coordinates or vice versa.  This is simply done using the 
first 2 icons on the opening screen, one being “setup” and the other “manual”.  In setup 
you select the primary coordinate base on the left side and the one to which the 
conversion will be made on the right.  Then select “manual” where you enter the lat/long, 
click “Convert” and read the results below.  These can then be copied and pasted into the 
input routine of QuickCogo. Corpscon6, itself, is not supported by the developer but he is 
willing to render any assistance necessary. 
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LIST POINTS WITH DATA 
This routine permits you to list the data in the file on the screen and print it with the printer. 
 It is accessed by selecting it from the Cogo Routines or button bar.  There is no sample 
window but it is self explanatory. You can choose the number of decimal places with which 
to display coordinates and elevations. The default is 3 for coordinates and 2 for elevations. 
The end box on the top right is for the points you want listed.  You may enter the word "all" 
or leave that box blank to list all of the points.  You may also list a range of points when 
you separate the first and last points of the range with a dot. You may also list random 
points when you separate each point with a space and then add a space after the last 
number.  To list a single point, follow it with a space.  The point list and data will be shown 
in the large display box. Use the scroll bars or arrow keys to view data appearing beyond 
the limits of the display area. You may also list in either feet or meters, keeping in mind 
that this option should not be selected unless you want a “feet” listing to list in “meters” or 
vice versa.  In other words, if you are working in feet and selected the “feet” option before 
listing, the program would assume you had been working in meters and wanted to see the 
listing in feet. To get back to the original list format, clear the option box by double-clicking 
it. Leave the options “Unselected” as a general rule.  A display box in the upper left corner 
allows you to list only certain elements of the file. The label is self-explanatory. However, 
the printer lists all of the elements regardless of the setting.  When you list random points, 
you must select “Print Screen” when printing or the random points will not appear in the 
printout.   CAUTION: Do not list more than 1000 points at a time.  Break them into chunks 
of about 500-600 points by using the range box.  This applies only if you wanted to print 
the entire listing and have the points listed numerically.  When breaking into ranges of 
points, each range will be appended to the previous one.  Clear the List screen before 
beginning. 
 
LAYOUT  
This routine calculates various points along a known line from a known point.  You must 
also have a point to sight from the known point.  The figure and the window on the next 
page show how this routine works.  Enter the point occupied and the point sighted.  Then 
enter the points for the known line with a start and end.  The distance that is entered as the 
last entry is the length from the start point toward the end point.  The display shows the 
angle right and the distance that would have to be measured to get the unknown point.. As 
you enter each distance, a new set of angles and distances will appear.  The distance you 
enter is shown to the left of the results of the calculation. Select this routine from the Cogo 
Routines menu. 
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                                                    LAYOUT POINTS ON A KNOWN LINE 
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The data entered in the above window does not reflect the diagram on the previous page.  
The point occupied should be 2, point sighted 3, start point 20 and end point 25.   The 
principle is the same, however.  The above screen also does not reflect the addition of an 
entry for a point number and descriptor so that the layout point and its data will be stored 
in the file. 
 
LEGAL DESCRIPTION WRITER 
This routine is accessed using the "Utilities" menu or with Shift+F8. It will assist you in 
preparing legal descriptions using the points in your file. The screen has several entry 
boxes, some of which are optional, in which either the points are entered or amplifying 
information is entered. The larger boxes are where the description is displayed and can be 
edited as needed prior to printing. 
 
The first combo box may be used to select a "beginning" phrase although it can be edited 
later if you normally use something different or I can add other phrases to the list. The next 
2 entry boxes are self-explanatory if you are using a bearing and distance to the pob. The 
next box is for additional info if only 1 course is not enough to get to the pob. The final box 
in that line is for a description of from where you have come to get to the pob, like a lot 
corner, a section corner, etc. You will need to add the word "from" as the first word.  This 
information will be displayed in the upper of the 2 larger boxes at the appropriate time. 
 
You can also select the units that you are using such as feet (default), meters, rods and 
chains (I can add others if needed).  
 
You should name your parcel for identification. 
 
You may also select the number of decimals to be used in the distances. 
 
The "Thence" box is for entering the point numbers. If the entire description is comprised 
of straight lines, you can enter all of the numbers at the same time in the order in which the 
boundary proceeds. They must be separated with a space (no space at the end). When 
completed, click the "Write Lines" button and the information will be displayed, the point of 
beginning stuff in the upper box and the remainder in the lower box with the proper 
bearings and distances. When you put a check in the "to POB" box, that phrase will be 
added at the end. If you want the area to also show, you can check the "Area" box but if 
picks up that data from the Area routine, meaning the area will have to be calculated and 
displayed there. It goes quickly and is a mirror of what you have entered before. 
 
Curves...when curves are part of your description, here is the procedure: 
1. Stop entering points in the box mentioned above at either the PC or POC. 
2. Determine if curve is right or left and select that option. 
3. Go to the "Points on Curve" box and enter the points as follows: pc or poc.pt or 
pot.radius point. These 3 elements are separated with a "dot". IMPORTANT: they must be 
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entered as though the curve is clockwise even if it is not. For example: looking at the figure 
in the manual used for lot closure, etc. which contains a reverse curve, let's say we are 
writing the description for that parcel. After our wording for the point of beginning, we 
would enter 1 2 3 in the points box and stop there because 3 is the pc of the first curve. It 
is to the right so we select that option, then enter 3.5.4 in the curve box (3 is pc, 5 is pt and 
4 is the radius point). Click the "Write Curve" button and the information is appended to 
what is already in the display box. We are now at the point of reverse curve so we select 
the "left" option and enter 7.5.6 in the curve point box. Note that we entered the numbers 
as though the curve was clockwise (but it is not). Again click "Write Curve" and that info is 
added. The rest of the boundary is straight lines so we replace what is in the "Points" box 
with 7 8 9 10 1 which completes the boundary of that parcel. Use the check boxes as 
explained above to complete the description. 
 
You can always add or delete anything by editing the display boxes. 
 
Click "Print" to obtain a hard copy. 
 
MINIMUM-MAXIMUM COORDINATES 
This routine uses the existing file data to display information that may be helpful in 
determining the limits of your file and how you could plan the mapping of it.  You could also 
use this feature prior to plotting in order to locate the limits of the file.  It is found in the 
Utilities menu.  No other entries need be made.  The results of this routine have been built 
into the Interactive Point Plot routine accessed from the Plotting menu. 
 
OFFSETS  (Figure does not include offsets radial to a curve in the alignment) 
There are 3 offset routines, Perpendicular, Reverse and Parallel.  They are selected from 
Offsets in the Cogo Routines menu.  The button bar only selects the perpendicular routine. 
The perpendicular offset calculates the tangent distance along a line and the 
perpendicular distance from it to a target point.  Refer to the figure below.  Set on point 10, 
sight 11 and enter the point numbers for the building corner and the manhole. You may 
enter a single point, a range of points (separated with a dot) or random points (separated 
with a space).  The range of points option will skip any points not in the file without causing 
an error. The display shows the 2 unknown distances with Right or Left from the base line. 
You may also use stations in place of distances along the sight line. The values will then 
be displayed accordingly.  
 
You may also obtain radial offsets to a curve as part of the alignment. Check the box 
"Curve in alignment" and a new frame will appear below with entry spaces for more data. 
You must use stations if a curve is involved. Enter the PC, Radius point and PT to 
calculate the radius and the delta angle. The display box will differentiate between the 
offsets from the tangent and those from the curve.  
 
The Reverse offset is the opposite of the foregoing.  Instead of computing distances and 
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offsets, the user provides that data and new points are calculated from the reference line. 
Instructions are contained within the routine. 
 
 

 
                                              PERPENDICULAR AND REVERSE OFFSETS 
 
Parallel offsets (figure on next page) allows you to calculate the P.I.'s of parallel lines at 
selected offsets to an angled reference line that has several points of intersection (P.I.'s). 
The points of intersection must exist in the file.   You will need to refer to the figure for 
point numbering assignments.  The point used as the next available point is always the 
first point for the P.I. on the Right offset and the next point is the P.I. on the left offset.  The 
next numbers alternate as shown.  The P.I.'s must be entered in a Clockwise direction, 
separated with a space.  0 (zero) must be entered as the last value.  A message appears 
indicating that the calculation is complete and that the numbers are now stored.  An 
instructional message box is displayed in the window at startup. 
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                                                                PARALLEL OFFSETS 
 POINTS UNUSED 
This feature computes the unused points in the file.  It is useful to determine which points 
are available when you don't want to use the next higher point.  Access it by clicking in the 
Unused box or from the Utilities menu.  The points appear in the long narrow box at the top 
of the screen.  If the points extend beyond the limits of the box, you can click somewhere in 
the box and use the right and left arrow keys to see all of the numbers.  
 
PARCEL OR LOT CLOSURE (MAP CHECK)  (See figure and window on next 2 pages) 

Select from the Cogo Routines menu or button bar.  This routine provides a fast method 
for checking the closure of a lot, tract or parcel of land.  Title people or attorneys may 
find it useful, in addition to surveyors.  This routine does not use point numbers.  
However, there are coordinates with 0,0 being the default.  You may use your own by 
changing the numbers. WARNING: Unless the parcel closes precisely, the area will be 
inaccurate based upon the size of the coordinates. The larger the number the greater 
the error. However, if you know the parcel closes, it doesn’t matter which you use. You 
simply enter the bearings and distances as you would in any traverse and press 
ENTER.  Azimuths are not permitted in this routine. Enter the word "Close" (it can be 
selected from screen) after the last course.  The closure information and the area will be 
displayed.  If there are curves involved, you must go clockwise around the figure. When 
you come to a curve, enter the word "curve" (it can be selected from screen) in the 
bearing box and press ENTER. The cursor will move to the "Bearing to radius point" 
box.  You must know the bearing to the radius point of the curve, the radius and the 
delta or select one of the other options PRIOR to entering “curve”. If an option was 
selected, the calculated data will appear as though you knew the other information.  
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Except for the Radius/Chord/Chord bearing option, the program assumes the previous 
course was tangent to the curve and will insert a *.1 or *.3 in the “bearing to radius 
point” box. If you know it is not a tangent curve, you must enter the correct bearing.  See 
below for reverse curves using other curve criteria.  When you enter these and press 
ENTER or click OK, the curve results will be displayed together with the last course from 
the radius point of the curve to the PT. The delta must be entered as a 7 digit angle.  
Enter it as negative if the curve is left.  If you find an error in the entries, you may edit 
what you have done. Press Reset then alternate between Edit and OK. When the errant 
entry comes up, change it and continue until the end.  The new closure results will 
appear. You may also create a file in which to place each closure for your own records 
or submission to a government agency. Create a text file prior to entering data by 
selecting that button. Then after each closure, click “Add to File” and the results will be 
stored in the text file that you created. Reset between closures. There is also the option 
to create a text file with points and coordinates as well as a QuickCogo file prior to 
entering data. Tenths of seconds may be entered for the bearing and number of decimal 
places may be selected for the display. There is also the ability to change the separate 
points/coordinate text file to conform with the format used in cad for drawings.  This file 
can then be made into a DXF for transferring the drawing and its annotation to a cad 
program.  Check box for DXF, not shown in screen shot. After completing the map 
check, close it, and select DXF. Follow the instructions on the screen and in this 
manual. Double click in the ‘Beginning Coord’ box to display the first coordinate in the 
larger display box.  This may be useful for submitting to government agencies. 
 
For a reverse curve: Since a reverse curve continues straight to the next radius point 
and practically has no tangent bearing the normal procedure will fail without making one 
of the following adjustments.  
1. Manually input the bearing to the second radius point  
2. After the first curve, enter *.1 in the bearing box and 0 in the distance box. This 
essentially turns a 90° angle to the right and establishe s a 0 length tangent line to which 
the next curve can relate. Then select an option, including the ‘curve left’ box, if 
applicable and proceed as before.  
3. After the first curve, check an option box, including the 'curve left' box, if applicable, 
click OK and replace the *.1 or *.3 in the 'bearing to rad pt' box with only the asterisk (*). 
Click OK (might take 2 clicks) and it should work properly. 
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            SAMPLE FIGURE FOR EMBEDDED ROUTINES AND MAP CHECK 
 (This figure may be used for practice in testing the routines) 
 
PUBLIC LAND SURVEY SYSTEM (PLSS) 
This routine subdivides a regular section into approximately 40 or 10 acre parcels or 
calculates a lost corner to be restored using the double proportioning method, using the 
1973 Manual of Instructions as the basis for the calculations.  One of the diagrams 
accompanying this routine is critical for the numbering plan when subdividing the section. 
When 40 acre parcels are subdivided, 25 points are numbered and placed in your file 
according to the plan.  This number increases to 81 points when 10 acre parcels are made. 
The numbering plan is shown on the diagram of the section and can be viewed when the 
red rectangle near the bottom of the screen is selected.  You may use any numbers you 
want but they must be relative to the plan for identification purposes.  The first 8 numbers 
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represent the section and ¼ corners beginning at the SW corner and proceeding clockwise. 
The center of section is always 20 numbers greater than the SW corner.  All other numbers 
are sequential according to a method devised by the developer.  If you are unable to use 
the same numbering along the boundary of the section as shown on the diagram, it is 
recommended that a constant be added to the 8 prime points.  For example, instead of 1, 2, 
3, etc., use 101,102,103, etc. if possible.  All of the section and ¼ corners must be known in 
order to subdivide.  If a found monument is to be used for the center of section (but is not at 
the theoretical location), be sure to enter it in the applicable box on the screen and add 20 
to the number you assigned for the SW corner.  This point is necessary for the subdivision 
of the section. The simplest method for assigning the same coordinate to a different point is 
through the bearing-distance traverse in the embedded routines. For example, let’s say you 
have run a traverse, locating the existing corners of the section but used arbitrary point 
numbers. You now want to assign numbers according to the plan on the diagram.  You have 
the North ¼ corner as point 26 but you want it to be 104.  Use 26 as the “Point From”, enter 
any bearing with a 0 distance to point 104. Now 104 will have the same coordinates as 26.  
Do the same with the other 7 corners. Of course, you may keep 26 for the ¼ corner but the 
other points will then have to be adjusted so that the SW corner will now be 23, the W ¼ 
corner, 24, NW, 25 and so forth. This scenario will make it more difficult to identify the 
parcels when compared with the diagram.  Use the Interactive Plot (Iplot) to display or plot 
the points or use QuickCogo’s other routines to obtain additional information.  NOTE: 
Sections bordering the North and West lines of the township have special 
considerations for their subdivision and are NOT in tended for use with this routine.  
 
TIP: If you have subdivided for 40 acres and then want to do 10 acre parcels, you will have 
to contend with point protection for the first 25 points unless you turn it OFF from the 
Options menu.  As an alternative, you may start a new file.  
 
Double proportioning to restore a lost corner involves locating the nearest corner in each 
direction from the lost corner.  Obtain the record distances (don’t worry about direction) 
between the found corners, then enter all information into the applicable boxes. Assign a 
point number for the lost corner. The calculation will be made using the “double 
proportioning” method according to the Manual of Instructions and the point will be placed 
in the file.  Tool tips may be viewed for the entry boxes when you hover your mouse there. 
 
RADIAL SURVEY  
This routine computes coordinates for points located in the field using the radial survey 
method, sometimes known as "wagon spoking" (angles and distances measured from a 
control point to a target point).  This routine uses the same principle as the Angle-Distance 
traverse except that the points are calculated from the same control point as in a side shot 
routine.  Select it from the Cogo Routines menu or button bar.  The window below shows an 
example of how the screen looks during the routine.  You can use elevations and 
descriptors and horizontal or slope distances.  The “occupied” and “sighted” points 
must be in the file or the program has no line to w hich the angles can be applied .  If 
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one is missing, an error will occur. If only a bearing is known for the first sighted point, you 
should use some arbitrary distance to establish a “backsight” point. This is only for the 
office calculations after the field work is completed. The inverse box at the top shows the 
inverse between the point occupied and sighted.  If you are using slope distances, then you 
will need to enter the vertical angle.  If not, you should enter the vertical difference from the 
readout on the total station.  
 
Azimuths can be used in 2 ways. If they are only chosen in the “Options” menu, then you 
will have to “zero” at each radial setup and turn an angle. The resulting azimuth is the 
previous one plus or minus the angle. The other way is to check the “Carry Azimuth” box 
and enter the actual azimuths rather than angles. 
 

 
 
 
RESECTION OR 3 POINT PROBLEM 
This routine computes the location of an unknown point by turning angles from the unknown 
point to 3 known points.  Data must be entered Clockwise.  This routine is accessed from 
the Cogo Routines menu.  The window is self-explanatory.  You enter the 3 known points, 
separated by a dot, assign a point number and enter the 2 angles turned.  The results are 
displayed. 
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RENUMBER POINTS 
This routine allows you to change all or selected point numbers in a file.  A duplicate file 
with an extension of ".dup" is created to protect the original file.  You can use it with this 
name or rename it.  Access this routine from the Edit menu.  Suppose you have a file with 
20 points in it.  You want to renumber points 5-10 so that point 5 will now be 21, point 6 will 
be 22, etc.  If you were to list the file after doing so, you would see that points 5 through 10 
are no longer there, but points 21 through 26 are.  Point protection is disabled during this 
routine. 
 
ROTATE DATA IN FILE 
This routine permits the user to rotate a defined range or all points in the file, using bearing 
or angle rotation.  The original file is saved with the extension ".bk" while the rotated file 
retains the same name.  Access the routine from the Cogo Routines menu or button bar. 
Enter the point from which the rotation will take place, the point to establish the bearing that 
will be rotated, press the space bar or click in the Old Bearing box and its bearing will be 
displayed.  Now enter the new bearing (QuickCogo format) and the selected points or enter 
"all" in that box to rotate all of the points.  Bearing rotation is the default, unless you select 
the Angle Option button to rotate by angle.  View the window on screen while reading this 
discussion. After rotation you may also translate the same points if necessary.  You are also 
given the option of rotating up to 3 groups of points. You may enter the New bearing as the 
inverse between 2 existing points. 
 
ROAD ALIGNMENT CURVES 
See discussion under CURVES, ROAD, pages 20-21. 
 
REVERSE OFFSET 
See discussion under OFFSETS, pages 36-37. 
 
SCAN FILE 
This routine permits the user to scan a file for all points within a given distance of another. 
Access this routine from the Utilities menu.   For example, suppose that you wanted to find 
all of the points within 150 feet of another point.   You would enter the point from which to 
scan and the near and far limits.  In this case the near limit would be 0 and the far limit 150. 
The display box would print all of the points which meet the criteria of your search.  Now 
say you wanted a point that was 149.5 feet from the scan point.  You would now enter 149 
for the near limit and 150 for the far limit.  This narrows the search considerably.  The 
display shows the inverse between the scan point and the other points. 
 
SLOPE DISTANCE 
See discussion under DISTANCES. You may toggle it on/off from the Options menu.  When 
on, it will trigger a Vertical Angle input box. 
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SPIRAL CURVES 
See discussion under CURVES 
 
STADIA SURVEY 
This routine was created as a customization and may not conform to the method you 
use. Brief instructions are on the screen when the routine is opened.  You will note the 
window is similar to the Radial survey window.  The routine works similarly except for 
entry of the readings for the top and bottom hairs of the instrument.  If you use stadia 
differently, perhaps I can further tailor it to fit your needs. 
 
STAKEOUT 
This routine permits the user to calculate angles or azimuths and distances to selected 
points from a control point on a known line.  All points must already have coordinate data. It 
can be useful in preparing information for a survey crew to set points in the field with pre-
computed data.  Access this routine from the Cogo Routines menu or the button bar.  The 
occupied and sighted points must exist in the file. Enter the point occupied and the one 
sighted, then a single point, a range of points (separated with a dot) or random points 
(separated with a space) in the “points” entry box.  The results will be displayed.  Use the 
scroll bars or arrow keys to see those results that extend beyond the borders of the box. 
The following window demonstrates how the routine works. The window below does not 
show the check box for displaying in azimuth. When checked, it will display azimuths and 
distances rather than angles and distances. 
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TRANSLATE 
This routine allows the user to change the coordinates or elevations in a file by a constant 
amount.  For example, if you had begun your file with beginning coordinates of 1000 North 
and 1000 East and began getting into many negative numbers, you could translate the file 
to reflect a different set of coordinates, all in the same relationship to each other.  Access 
the routine from the Cogo Routines menu.  A new file is created with the original 
information, with the extension of ".TRL".  An example window is shown below.  The 
Coordinates option is the default.  Enter the file to change (the current file is the default) 
and the point which controls the change.  When the cursor is in the Existing coordinate box, 
press Enter or the space bar to display the coordinate.  Now enter the new coordinates in 
the box below it. Enter the points to be changed or the word "all" for all points.  Elevations 
work similarly. Make sure the control point is included in the range of points selected. 
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VERTICAL CURVES 
See discussion under CURVES 
 
SCREEN AND PRINTER PLOTTING   
Although QuickCogo  does not produce finished maps, it offers screen and scaled printer 
plotting in several routines. Plotting provided by this software is intended only for internal 
use (tracing, planning, review, etc) and not for distribution.  The routines containing plotting 
are bearing-distance and angle-distance traverses, area, radial survey, offsets, lotplot and 
Interactive Plot. The interactive and lot plot routines may be accessed from the button bar 
but the others are retrieved from the Plotting menu.  All plotting is displayed in a shaded 
box that overlays the underlying screen of the routine and is based upon the relative 
coordinates of the lower left and upper right corners of that box. In most of the routines, 
these coordinates are calculated for you and shown in the window below. They can be 
edited.   
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The plot parameters window below is the one in which plotting limits and other selections 
are displayed after being calculated. Aspect is the ratio of the width and height of the 
plotting area, the ideal being 4/3. There won’t be a noticeable difference when only lines 
are drawn but curves will not display correctly when the aspect ratio varies significantly. 
Internal calculations attempt to accomplish this task using the minimum and maximum 
coordinates in the file. The plotting parameter window is accessed from the Plotting menu.  

 

 
 
However, you may never have to use this window except to note the scale by which the 
printer plot will be made.  For custom plots, you may also control the placement of the figure 
by changing the limits of the plotting box.  The bearing-distance and angle-distance plotting 
routines contain a “Printer Limits” check box to permit user setting the limits, mainly to 
position the drawing on the printed page. Printer plotting is controlled independently of the 
screen plot as noted above. Since the paper upon which the plot is made is 8.5x11, the 
upper left corner generally receives the same east coordinate as the lower left and the 
same north coordinate as the upper right.  East is ALWAYS placed before North. A scale 
must also be entered. This scale is compatible with an engineer’s scale (20,30,40,etc.) and 
controls the bottom right coordinates of the paper. This is also automated during the 
plotting routine so that you don’t have to think about it unless you want to change the limits. 
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The window above shows existing points displayed. From here you can inverse, traverse, 
display the coordinates, draw lines and curves, etc. A full discussion is contained within the 
routine itself and hereafter in this manual. Added to the Interactive plot was a check box for 
printing the inverses obtained through clicking the points displayed.  There is also a check 
box labeled “Point Finder”.  This allows the user to widen or lessen the area around the 
displayed points in order to “select” them more easily.  When the points are small in the 
display, it may take some time to select it exactly so if the point finder area is enlarged, they 
will be easier to find.  You may dxf a drawing (lines, bearings and distances) of any 
configuration made with the existing points.  Select the check box in blue to create a 
point/coordinate text file. You must be in the “Lines” feature for this procedure to work. If 
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you plot the lines first, you can then reselect each point contained in the figure for 
transferring.  It will not select the points while lines are being plotted.  If you select the 
points first, the lines will not plot but the point/coordinate file will be valid. 
 
 
 
 
 
 
PLOTTING BASICS 
Before discussing individual plotting routines, it will be helpful to review the following 
conventions: 

1.  Lines are drawn as solid unless another line type is chosen in the bearing-
distance traverse routine.  When automated, all lines are the same types.  To use 
various line types, turn off auto sizing by checking “Set Limits”.  
2.  Point numbers are shown in the screen or printer font chosen. 
3. The plotting box may be moved laterally on the screen by placing the mouse 
pointer near the top left side of the box and moving it.  When the mouse button is 
released the box assumes a new position according to its top left corner.  It may take 
several tries for acceptable results. See the next item for a quicker way. 
4.  In those routines where the box may be in the way of text (Embedded, Area, 
Angle-distance traverse and Radial survey), a small filled-in square near the top 
right corner of the box is a toggle for the visibility of the plotting box.  When clicked, 
the plotting box is toggled on or off but does not lose its contents.  
5. While printer plot is activated, the plot remains in the printer’s buffer until you 
send it by pressing Ctrl+F7 or clicking the printer plot or similar button if applicable. 
If you exit the program prior to printing, the data in the buffer will be sent to the 
printer. 
6.  Use Ctrl+F8 or the Clear button to erase the plot from the screen.  Ctrl+Z exits 
you from plotting. 
7.  The printer must be the one set by Windows.  Laser or ink jets work best. In some 
cases, you may have to emulate a dot matrix printer to an acceptable one that 
accepts plotting.  For example, a Panasonic printer may have to emulate an Epson 
or IBM Proprinter.  Try the one you have first and find out which other ones it 
emulates. 
8.  In some routines, the user has the selection of line types. The defaults produce a 
thin, solid line. These line types are also reflected in the printer plot. You may also 
choose "None" for the line type if you don't want a line to appear, such as the line to 
the radius point of a curve.   
9.  Curves may not plot properly on the screen when the plotting area does not have 
the ideal limits as described previously although the printer plot will appear correctly. 
This has been minimized as much as possible through the automated calculations. 
10.  The plotting boxes are shaded areas on the screen intended to represent a 
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sheet of paper.  The user can not change the size of the shaded area. The 
coordinate limits dictate the appearance of the screen plot. 
11. Regardless of how the lines look on the screen, the printer plot will be accurate. 
12. A text file is created automatically for Bearing-Distance, Angle-Distance and 
Radial plotting. It has a bdplot.txt, adplot.txt or radplot.txt appended to the name of 
the open file. This file can be retrieved and opened for re-plotting from the Data 
Entry Files menu. 
 

A review of the plotting routines follows: 
1. Select the routine you will plot (area, angle-distance traverse, bearing-distance traverse, 

parallel offset, perpendicular offset and radial).  
2. Select the “Plotting” menu. Get in the habit of selecting the routine FIRST or an error 

may result. 
3. Select the applicable plotting routine from the “Plottting” menu. 
4. If using the bearing-distance or angle-distance routines, a new window will appear for 

selecting the beginning point and entering its coordinates. If it is an existing point, the 
coordinates will be displayed. In routines other than the 2 traverses and where 
coordinates already exist, the lower left and upper right limits for the plot are calculated 
internally and assigned to the appropriate lines in the “Plotting Parameters” routine 
where you may view and edit them, if necessary.  Instructions for plotting to the printer 
will be covered later.  A shaded box represents the plotting area.  Enter the data and 
see the plot made when you press Enter or click OK after each data entry.  If this is a 
new traverse, no limits will be available until after you begin entering data. You can 
close plotting with Ctrl+Z or selecting from the plotting menu.  

5. You may clear the plotting area with Ctrl+F8 or from the plotting menu.  You cannot 
erase lines already plotted. Clicking the filled-in square near the upper right corner of 
the plotting screen will hide the plotting area in order to read the text underneath.  It is a 
toggle.  You may plot with the plotting screen hidden by entering the data normally for 
that routine so long as plotting was initiated either by clicking the square at least once or 
by selecting through the menu.  When the screen is made visible again the plot will 
appear according to the data entered.  You may make the plotting area appear and 
disappear anytime by clicking the square. This applies to all routines where the square 
is displayed. 

6. A “Plot File” button may appear near the square. This button is only for those routines 
where a text file is created as described hereafter.  DO NOT use this button if you are 
plotting with your own limits, except in the Radial routine when restoring the entire plot. 
The automated drawing made while plotting in bearing-distance and angle-distance is 
placed in the upper left corner of the printed page by default. It plots to scale properly 
but may be inconveniently located for your purposes. A solution is described hereafter.  

7. The paper plot was calibrated for scale using my printers (HP inkjets) and may not scale 
exactly on yours. If it is more than 1 unit off at a 20 scale, let me know and I will try to 
calibrate it for your printer. It may take several tries. 

8.  The scale may be computed internally for those routines without an individual entry for 
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scale value. It is shown in the Plotting Limits window. If not, you MUST enter a scale in 
order to plot to the printer. 

 
QuickCogo  will assist you in making drawings on the plotting screen or through the printer. 
With minimal planning, you will be able to adequately draw simple figures from surveys, 
traverses or maps.  Annotation, except for point numbers, is only available in the LotPlot 
routine (See LotPlot).  DXF will transfer maps and annotation to a cad program. 
 
CAUTION: Plotting boundaries are automatically established from the coordinates in the 
file. Isolated points far away from the others, like the radius point of a long curve, may 
distort the boundaries and render the plot unusable.  Such points should be temporarily 
removed or copied to another file before proceeding. 
 
INTERACTIVE PLOT 
This routine is one of the most useful of the various plotting routines. It permits the user to 
display points from an existing file and interact with them or create new ones. There are 
several options which can be used after the points are on the screen. The current file is the 
one used. The program  scans the file and figures the lower left and upper right coordinates 
based upon the maximum and minimum Easting and Northing. This is done after points are 
displayed. In the upper left corner is a "Range of Points" box where point numbers may be 
entered in several ways. 
1. Enter "All" and every point in the file is used to calculate the limits and shown at the 
lower left and upper right corners of the plotting box. When "Display Points" is selected all 
of the points are displayed. If point 1 is not in the file, you may get a “First point not found” 
message when using “All”. In that case, use a ‘range’ of points. 
2. A range of points separated with a dot will display just those points after calculating their 
limits. 
3. Random points separated with a space will display only those points entered. These may 
be entered in any order and the program will then rearrange them into ascending order 
automatically and display them as such in the Point Range box. 
4. With the "Draw Lines" option selected, the method in (3) will draw lines between the 
points in the order you entered them and close the figure with a line from the last point 
entered back to the first. To suppress the closing line being drawn, enter a "0" (zero) as the 
last number. 
5. With the "Draw Lines" option selected, you may draw lines between consecutive points 
automatically when you enter the range separated with a "-" (dash). A closing line will be 
drawn but it also can be suppressed after by entering a "0" (zero) as the last number.  Be 
sure all of the points exist. 
6. When the points are not in a convenient location on the screen, you may change the 
limits of the plotting box.  Check the “Change Limits” box, then enter new limits in the next 
screen. You will note the new limits are displayed in the lower left and upper right corners of 
the plotting box. 
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You may mix and match the methods. For example, if you have displayed all of the points 
and now you want to draw lines between several of them but leave the others visible, click 
the “Point Range” box to highlight the entries, then enter the points desired, separated with 
spaces. You may backtrack over a point if necessary. You could then click other points to 
draw lines between. Experiment as needed. 
 
With (4) and (5) the area will also be displayed on the right side after the points are shown. 
 
TIP: When a figure has most or all points only a few distance units apart, the plot will not be 
practical. In that case, multiply all the distances by some factor like 10 when computing the 
coordinates and re-plot.  See DISTANCE MULTIPLIER for details.  
 
Display point numbers is the default. You may also display elevations and descriptors by 
checking those items. 
 
If printer plotting, check those boxes on the right side PRIOR to displaying points. The scale 
will be calculated for you for all of the above methods. However, occasionally the scale 
computed may generate a scale that causes the drawing to be too large for the paper and 
prints several blank pages. In that case, simply "Reset" and enter the next smaller scale 
(larger number) prior to displaying points again. The scale can be any number but the 
calculated ones are 10, 20, 30, 40, 50, 60, 100 and 200. The scale is inserted in the "Scale" 
box when the printing is being done.  You may also enter the scale PRIOR to displaying the 
points and it will be used for the printer plot. This is the method recommended. 
 
The "Reset" button will not delete the point number entries in the "Point Range" box. This is 
convenient for using those numbers repeatedly or changing numbers for trial and error 
plotting.  Reset does clear the Options and check boxes for elevations and descriptors.  
 
If several sheets come out unexpectedly while printing, the scale was not proper for the 
range of points selected and only a few points will be plotted on each sheet. This should not 
happen under normal circumstances and if it persists, please send me the qcw file being 
used and the selections made prior to printing. 
 
After all the selected points are plotted, you are ready to choose an option to interact with 
them. If you selected to display all points they may be crowded together and not easily 
distinguishable. In that case, you may have to re-display them using one of the methods 
described above. Using “Reset” and adjusting the point range quickly does it. Practice will 
help you learn.  
 
There are 2 check boxes at the bottom of the screen so that you can save the plot you 
made.  Following are instructions relative to that procedure if you are going to re-do a 
printer plot at a later date: 
 



 
 

72

1. Using the active file, check the 'Printer Plot' box and any other items for the drawing.  
2. Enter the range of points and click 'Display Points' 
3. Check the 'Make File' box and name the file. It will be placed in the same folder as your 
program file. I can change this if you prefer a different folder. 
4. Join the dots for your plot. 
5. Click 'Print Plot' and it will plot through the printer.  
6. Now, let's say you come back tomorrow and want to replot the drawing. 
7. Open the same file as in (1). 
8. Check 'Printer Plot' and other items as needed. 
9. Display the points as in (2) 
10. Check the 'Run File' box.  Name the file (same as in (3)) 
12. You will see the lines automatically appear. 
13. Click 'Print Plot' and it should plot again.  
NOTE: If you do this immediately after the first plot as in (5), be sure you click 'Reset' first 
before doing the other steps. 
 
There is a ‘Hdg’ check box near the bottom of the screen.  When checked, you may enter 
text that will be printed as part of a title for your drawing.  You may enter 2 items, such as 
the name of the drawing and your name or company for the first 2 lines.  The next 2 lines 
show the scale and the date.  This title will appear near the lower right corner of the sheet 
when the drawing is plotted. It may be left off by not checking the box.  If you have saved 
the plot, you may plot several copies of the drawing without re-entering the title’s text by 
resetting between each copy.  However, if you have closed the routine and come back later 
to re-plot from your saved file, you will have to re-enter the first 2 lines again. 
 
Point Finder...As previously discussed, at the lower left corner of the screen is a box 
containing a default number of 5. This number represents the radius of an imaginary circle 
for selecting a point contained within it. When the limits of the plotting screen are far apart, 
the dots representing the points are sometimes too small to accurately click with the mouse 
pointer and the default of 5 may not give enough separation to locate the point. In this  
case, increase the number in the "Point Finder" box and try again. Decrease it if that value 
is too large and a point other than the desired one is found.  Point finder is not effective for 
points with very small separations. 
 
Inversing...Click the points between which you want the inverse and it will be displayed on 
the right side. Keep clicking and each inverse will be shown, appending to the others. To 
stop the continuous feature, double click within the plotting area and start a new point 
series.  If more than one point has coordinates within the Point Finder range, the lower 
number will be selected. If this is the case, you may also use the ID/INV frame appears after 
you have selected the option. Within that frame is a box for entering points between which 
to inverse. Separate them with a dot and click OK.  The results will be displayed above in 
the same area as before. You may mix and match the methods. If you want to print what 
you have done, click the Print ID/INV Display button below.  Since this box also displays 
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Point ID’s, everything in the box will be printed.  Double click within the frame to close it. 
  
 
Point ID shows the coordinates, elevation and descriptor of each point selected. Simply 
click the point and view the results on the right side.  However, if several points essentially 
have the same coordinates, ID will choose the lowest point number as it searches the file. 
Although the coordinates are the same, other data may not be.  Recommend deleting or 
renumbering points with same coordinates after copying them to another file before 
selecting them from the screen. (See Copy)  OR…when you select the ID option, a small 
frame with a entry box and OK button opens on the right side.  You can enter the point 
number for which you want the ID in the box and click OK. The information will be displayed 
in the box above where other information is shown. It does not replace what is there but 
appends to it. Double click within the frame to close it.  You may also print that display by 
selecting the “Print ID/Inv Display” button below. 
 
  
B-D Traverse...is a bearing-distance traverse from an existing point on your screen or a 
new point just set with the “Set New Point” option. This routine is not intended to replace 
the one designed specifically for that procedure but only to allow the user to add points to 
those already on the screen without returning to the "Embedded" routine or the one 
accessed through the "Utilities" menu. It also works in conjunction with the "Set New Points" 
option that will be described later. A new frame opens on the right side when the B-D 
Traverse option is selected. Within this frame are entry boxes for Bearing, Distance and 
Point, together with OK and Plot buttons.  First, click the point from which you will traverse. 
This point has a number and data that are retrieved by the program. Now enter a bearing, 
distance and next point into the boxes and click OK. A line will be drawn from the point first 
selected to the next point. Enter another bearing, distance, etc. and lines will continue to be 
drawn. If you want to printer-plot the figure at this time (if the printer options have been 
selected) click Plot and it should happen. You may also click "Print Plot" but you may have 
to click it twice. Double click within the frame containing the bearing, distance boxes to 
close it.  
 
Compute Area... calculates the area by clicking the points in a clockwise manner around the 
boundary to be figured. When you click the first point again, the area is computed and 
shown on the right side.  Double click within the plotting box to set the area back to zero for 
your next calculation. At this time, the area of a figure with curves is not available in  
this plotting routine but is in other calculation routines throughout the program. 
 
Draw Lines...is used in two ways. The most straight forward is to draw lines as you click the 
points but a more convenient method may be to select this option before using (4) or (5) 
above (not from make and run file explanation). The lines are then drawn automatically 
between the numbers you select. This option must be selected before displaying points with 
the last mentioned methods. The methods also may be combined. If you want to skip 
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around while clicking between points, double click within the plot area before clicking a 
different series of points. 
 
Set New Points... means that you can set random points in the plotting area. It would 
primarily be used for a bearing-distance traverse from scratch by setting a point and then 
traversing from it. However, it can also be used after an existing file has displayed its 
points. WARNING: Plotting limits MUST be in place before selecting this option. If it is a 
new file, you will have to set the lower left and upper right limits so that the point to be set 
will be relative to them. You can call the Plotting limits window by selecting it from the 
Plotting menu. After setting the limits, set the point by clicking at an arbitrary spot in the plot 
area or on an existing point, then numbering the point at the prompt that appears. The point 
will be represented and the point number will be placed beside it. 
 
Draw Curves...Select when you want to plot a curve as part of a figure. Click the point from 
which the curve is drawn. Input the bearing and distance to the center and the delta angle. 
Use a minus for delta if the curve is left. If you are running a bearing-distance traverse with 
curves, traverse to your PC, radius point and PT before drawing the curve.  Ignore the 
location of the curves when plotted on the screen. They may not be close to the pc or pt on 
the screen, but the printer plot will be accurate.  If using Iplot with curves, I recommend 
displaying only the points, then drawing the curves, then the lines manually prior to printing. 
For best results with curves, use LotPlot or Bearing-Distance Plot. 
 
Erase Lines...To erase a line select the 'Erase' option and then click the end points of the 
line. If the printing option is on, the line(s) will NOT be erased on the printed sheet. 
 
Tip: Use the check boxes to show various attributes of the points, like point number, 
descriptor and elevation.  Display point number on the screen is the default. However, 
points close together will be confusing. Try using the (4) or (5) methods to plot only those 
points you need. 
 
Descriptors show in blue and elevations in red. You can have any combination of point 
numbers, elevations and descriptors displayed. When possible, try to keep descriptors 
short and elevations to 4 digits or less. It will be especially useful if you were manually 
plotting a topo and wanted the information to show on the printed copy. 
 
Make dwg DXF...makes a text file while the "Draw Lines" option is enabled for later entering 
into the DXF routine.  An input box appears for you to enter the name of the file with which 
you are working. It will create a text file with that name and the extension of “.txt”. After 
points are displayed, enable the "Draw Lines" option and click the points in the order the 
lines are to be drawn. The lines will be displayed if you have not selected the DXF option. If 
you have, the lines will not be displayed but the necessary data will be created in the text 
file. If you have displayed the lines and then selected the DXF option, click through the 
points again to place the data in the text file. You may find it easier to draw the lines before 
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selecting the dxf option. That way it is clearer to you how the points defining the figure 
should be selected. With all of the points on the screen, it is feasible to actually prepare an 
entire subdivision or complex map to tranfer via dxf into a cad program. Not only are the 
lines transferred, but the bearings and distances along the lines.  The text file created is in 
your default folder with the program file and is the one you must enter when you 
subsequently choose the dwg option in the DXF routine. 
  
If you have a problem or a particular plot you want to do but can’t figure it out, please 
contact me and perhaps I can help. 
 
PLOTTING THE BEARING-DISTANCE TRAVERSE 
This routine allows you to see the progress of the bearing-distance traverse as you enter 
the values. From the “Embedded” screen, select Plotting,  “Bearing-distance traverse” from 
the top menu OR put a check in the “Plot Traverse” box The following instructions assume a 
new traverse in an empty file after selecting one of the options mentioned. 
1. A window will appear for setting the beginning point.  If the point you enter is an existing 

one, the coordinates will automatically display. Otherwise enter your own. 
2. You could use the diagram for Parcel Plot found in this manual.  If so, enter point 1 and 

1000 1000 as the coordinate s. Close the window and a shaded box for the plotting area 
will be displayed.  Begin entering bearings and distances around the figure, starting with 
point 1.  After pressing Enter or clicking OK, the line will appear in the shaded box. The 
first line will almost fill the area. When the next course is entered, the lines will 
automatically be re-sized so they both fit in the area. As you proceed around the figure, 
all lines will be made to fit.  Plotting curves will be explained later on. Ignore them for 
now by traversing between their radius points. Although the bearings and distances may 
not be displayed accurately on the screen due to the changing aspect ratio, they will be 
accurate when plotted with the printer. 

3. When you chose “bearing-distance plot from the menu, a text file with the same name 
as the coordinate file is created with “bdplot.txt” added to the name. For example, if the 
name of your file was “test.qcw”, a file with the name of “testbdplot.txt” is created in the 
same folder. This file receives your data entries, similar to a data entry file. It can then 
be used to re-plot the figure or make changes with a text editor. There is a button 
labeled “Plot File” near the filled-in square which, when clicked, re-displays the plot on 
the screen. This file is available whenever necessary. Caution: New data will be 
appended to this file unless you delete or remove the entries you don’t need.  You may 
remove all data from the file by selecting “Reset” from the window that appears when 
selecting the beginning point. To save the file, rename it before resetting. 

4. You may also plot by selecting your own limits in order to control the placement of the 
drawing on your screen and the printed sheet. The simplest way is to check the “Limits 
for Printer Plot” box and enter your own coordinates in the Plotting Limits window. This 
turns OFF the auto-sizing feature.  In the case of the sample diagram, 985 920 for the 
lower and 1255 1122 for the upper will work well. Either a 20 or 30 scale will make the 
printer plot appropriately. Enter the bearings and distances and they will appear after 
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each course. You may bypass auto-sizing altogether and start your traverse after setting 
the limits from the Plotting Limits window without selecting “Bearing-Distance traverse” 
from the Plotting menu, then clicking the square. ALSO SEE (10) BELOW. 

5. If you by-passed auto sizing as described in the last sentence of (4) and had a data 
entry file, return to the “Data Entry Files” menu, select “Bearing-Distance Traverse”, 
“Run File”. Name the file with the same name used to create it. If you edited the file, say 
“Yes” to the message box. This will activate the point protect feature and will store the 
new coordinates when a changed point is encountered during the re-run. If it has not 
been edited, select “No”, the default, and there will be no interruption by the point 
protect feature.  When you close that box, the plot of the boundary of your bearing-
distance traverse will be displayed.  If you want to change its location in the plotting 
area or on the printed page, select “Plotting Limits” under the “Plotting” menu and make 
the adjustments.  

6. This file or one created with auto-sizing will remain in your computer for further plotting 
or editing.  You can restore a plotting file by selecting it from Data Entry Files>Bearing-
Distance>Plot File Name and then clicking the Plot File button. 

7. You may also plot between points by using their inverses. This is helpful for plotting 
interior parcel lines. 

8. Experiment until you are familiar with the way this routine works. 
9.  Printer Plotting.   The following information supplements that described in (4) above.  

Select “Plotting, Bearing-distance”.  If this is a new traverse, set your beginning point 
and its coordinates and run it as described previously.  When completed and the 
drawing is displayed on the screen, check “Limits for Printer Plot” box near the “Plot 
File” button. This turns off the auto-sizing feature.  The Plotting Limits window will open. 
Enter values under the “Printer” heading for the top left corner of the sheet, the scale, 
and other items if default values have not already been placed there.  When a value for 
the scale is entered, the printer is activated. You can also adjust the lower left and upper 
right corners of the plotting box if you want to move the figure on the screen. The 
plotting box coordinates were already figured for you to allow some margins but can be 
changed. Normally, the lower left east and the upper right north are the defaults for the 
top of the printed page. As you decrease the east coordinate, the drawing should move 
to the right and as you increase the north the drawing will move down. Close that 
window and click the “Plot File” button to replot the figure now with printer data. If you 
did not change the “Plotting area” coordinates, the drawing will plot in its same location 
on the screen. Now when you plot the file to your printer, it will be according to the 
coordinates you set. Do it a few times to get a feel for how you can move the drawing 
around. It is all based upon the limits of the coordinates for your drawing and those for 
the plotting area and printed page.   The same principle applies if you are using an 
existing traverse and want to restore it using the plot file name. You must first select 
Plotting>Bearing-Distance and then follow the procedure previously explained. Note: 
Whenever a value is placed in “Scale” in Plotting Limits, the printer is on. 

10. TIP: Ctrl+F9 will activate the “Bearing-Distance” input box for obtaining additional points 
without having to use the Embedded routine.  For example: Let’s say you plotted a lot 
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boundary and now want to place a building on it and know the distances from the lot 
lines to the corner of the building. If you continued your plot routine with auto-sizing, 
lines would be drawn as you traversed to the building corner, producing an unwanted  
result. However, by using Ctrl+F9 (or from the “Utilities” menu) you can run a bearing-
distance traverse to obtain the coordinates of the building corner without disturbing the 
drawing. Then enter the point defining the building corner in the “Point From” box in 
Embedded and continue your plot from there to outline the building. I have found this a 
definite advantage. This utility can be used anywhere and is very handy. 

 
Example: (Different scenario) 
1. Begin a new file.  Select Plotting, Bearing-Distance Plot or Check the “Plot Traverse…” 
box.  
2. New Window…  Enter 1 for point number and 1000 East  1000 North. Click OK. 
3. Embedded screen with shaded plotting area... Enter a few bearings and distances to see 
how the lines and point numbers appear without leaving the borders of the screen. 
4. Close that routine. 
5. Open it again. 
6. Select Plotting, Bearing-Distance Plot 
7. New Window…Enter 1 for point number…the coordinates automatically are entered. 
8. Embedded screen with plotting area…click ‘Plot File’ button.  Previous plot is displayed 
but maybe not in same relation to the screen. 
9. Put check in ‘Limits for Printer Plot’ Box.   
10. Plotting parameters screen opens.  Remove numbers in Printer Plot box. Change ‘upper 
right’ numbers slightly. Click OK. 
11. With check in box, click ‘Plot File’ button again. Plot appears in different location. 
This is how to move the plotted figure around in the plotting area.  If you wanted to plot the 
figure to the printer, leave the numbers in (10), add a scale and click ‘Plot File’ again, then 
Ctrl+F7 to send it to printer.  Experiment until you feel comfortable with the procedure.  
Please contact me if there is a certain plot you want to make but can’t get it to work. 
 
 
 PLOTTING CURVES 

Generally a bearing-distance traverse consists of straight lines only. However, there 
may be a time when you want to plot a figure containing curves such as a 
subdivision lot or parcel of ground. This can also be done in this same routine.  
When curves are part of your figure, you MUST go in a CLOCKWISE direction. To 
plot a curve, enter “pc” after the point number at the beginning of the curve, “rp” after 
the point number for the radius point and “pt” after the number for the last point on 
the curve. If the curve is left enter the point number for the rp as negative.  Refer to 
the figure used for the Parcel/Lot closure discussion and for the embedded routines. 
 For example, after entering point 3pc which is the PC of the curve, enter the bearing 
and distance to the radius point of the curve (S15°E 40) , point 4rp and then enter the 
bearing and distance to point 5pt (N29°E 40). You may want to change the line type 
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to the radius point to “dotted” or “None” depending upon the use of the plot.  In the 
sample diagram, there is a reverse curve. At the point of reverse curve, enter a 0 
distance to simulate a new point for the pc, since each curve item needs a 
coordinate.  For example, in the diagram, you would enter any bearing from point 5 
and a 0 distance to point 6pc (same as 5pt) such as N29°E 0  and then N29°E 54 to –
7rp, the radius point for the next curve, which is to the left.   
 
There may be times when there are long radius curves whose radius points fall far 
away from the nucleus of the figure. If automated plotting is used, the drawing will be 
sized down considerably and may not be usable although it will be accurate. In this 
case, it is recommended that you set your own limits based upon the projected 
maximum and minimum coordinates of the figure.  Simply set the limits using the 4:3 
aspect ratio, click the filled-in square to display the plotting area and begin entering 
data. The curves should plot accurately regardless of the length of the radii. DO NOT 
use the “Plot File” button.  You might also consider removing the point defining the 
radius point temporarily and using a straight line for the curve (if a very long radius) 
or simply free-handing it in after plotted. 
 
REMEMBER: A text file is being made as you work when using the automated sizing 
feature. It can be edited to correct any errors made. It has the same name as your 
underlying file plus “bdplot.txt”. You can use this same file over again by resetting it. It 
may be saved by renaming it first. 

 
 
 
PLOTTING FIELD TRAVERSE (ANGLE-DISTANCE).   
This routine works like the other plotting routines.  After selecting this routine, choose the 
plot routine from the Plotting menu or check the ‘Plot traverse….’ Box.  A warning message 
appears that indicates a CLOSED traverse can NOT be done with the auto-size feature but 
must be run using your own plotting limits entered manually as described previously. The 
programming method to obtain closure data for the CLOSED traverse is not compatible with 
the method to auto-size the display of lines.  If you want to plot a closed traverse, you 
should click the ‘Cancel’ button and do it with manually entered plotting limits OR run the 
closed traverse without plotting by simply entering the data and observing the results.  If 
you need a sketch, you can run it as an OPEN traverse.  The OPEN traverse utilizes the 
auto-size feature.  For large traverses, a data entry file should be made.   
 
You can leave out point numbers but lines are always plotted whether they are selected or 
not.  There is no option to plot just points.  You MUST have at least 2 points from which to 
begin. The second point may be established either by inputting it or running a bearing-
distance traverse to set it.  (See another method for bearing-distance described previously). 
Again, a text file is automatically created, this time with the file name and “adplot.txt” added. 
You may use this file as described in “bearing-distance” plot.  Elevations and descriptors 
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are not carried in the text file.  The plot will size itself according to the angles and distances 
entered. The filled-in square in the upper right corner near the plotting area permits you to 
toggle the plotting screen OFF/ON in order to view the text if necessary.  Ctrl+F7 will plot it 
to the printer if that selection was made. See the underlined information concerning the text 
files created in the discussion for bearing-distance traverse. As stated before, you may 
forego the auto-size feature by selecting your own limits, clicking the filled-in square and 
proceeding. Same principle applies with the “Limits for Printer Plot” check box.  
 
PLOTTING OFFSETS 
The parameters will automatically be set based upon the coordinates in the file. In the 
Perpendicular routine, points only with their numbers, are shown on the screen and on the 
printer plot.  The printer plot has tiny black dots which represent the exact offset point to the 
base line, which is shown as a solid line.  In the Parallel Lines routine, enter the points for 
the existing P.I.s and add a 0 at the end of the row.  Each point must be separated with a 
space.  The plot will show a dashed line between the p.i.'s and a heavy solid line for the 
offset lines.  Although the offset lines are drawn parallel with the back and forward tangents, 
 there are no point numbers assigned to the points perpendicular to the first and last points. 
 
LOT PLOT   
This routine is in connection with the Lot Closure or Parcel routine.  It provides the 
opportunity to plot a parcel with or without curves to the screen and the printer. You can 
select screen and printer plot annotation and optionally the closure information to be 
output to the printer.   It can be accessed from the Plotting menu.  There are no 
coordinate parameters to set and there are no point numbers involved.  There are 2 
display boxes in the window.  The one on the left is the plotting area and the one on the 
right is where the bearings and distances entered are echoed.  The plotting area 
represents an 8.5 x 11 sheet of paper and anything plotted in it will appear on a printer 
plot in the same relative location.  The only plotting parameter needed is the Scale to 
which the figure will be plotted.  This is entered as 10, 20, 30, etc.  You may select the 
line type for each line before it is plotted.  The type chosen remains until you change it. 
Now pick a point in the plotting area where you wish to begin the drawing.  Click once 
with the mouse button after you have entered the scale and, optionally, the first bearing 
and distance.  When you press ENTER, the first line is plotted from the point you set 
with the mouse.  Do not click in the plotting area again after the first time. The lines will 
plot after the bearings and distances are entered. Proceed in any direction around the 
figure if there are no curves involved, but only clockwise if there are.  After each bearing 
and distance is entered, the area on the right displays the information.  When you have 
entered the last leg of the figure and want to know what the closure is, enter the word 
"close" in the Bearing box.  The closure information and the area of the figure is 
displayed.  If you want the routine to close the figure for you, enter the letter "C" in the 
Bearing box.  A line will be drawn between the last and first points and its bearing and 
distance will be noted together with the area of the figure.  When you come to a curve, 
enter the word "curve" in the Bearing box.  Three input boxes will appear asking for the 
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bearing to the center, the radius and the delta angle.  Another box will appear asking if 
you want dashed lines shown between the center of the curve and the pc and pt.  The 
default is NO.  The center is still noted with a small dot.  The bearing must be entered 
as a 7-digit number, as must the delta angle.  The curve is then drawn.  If the curve is 
left, the delta angle must be entered as negative.  The curves may not be precise on 
your screen because of the aspect ratio of your monitor, but they should plot properly on 
the printer plot.  However, you may find if the center of the curve is well beyond the 
limits of the 8.5 x 11 sheet, the curve will not plot properly.  You may want to change the 
scale of the drawing or draw the curve by hand.   When you are done, send the plot to 
the printer with the F7 key.  MANUAL plotting is accessed by entering the letter "m" in 
the bearing box after clicking a point in the plotting area.  From then on, each time you 
click another point, a line will be drawn between the points, with the bearing and 
distance between them shown in the display box.  Enter “a” in the bearing box and an 
approximate area will be show. You may also enter close but the closure error 
information will not be correct.   Enter "mc" and you can plot curves manually with the 
same restrictions regarding the center of curve.   Click the pc (which is counterclockwise 
from the pt) and answer the prompts from the input boxes that follow.  You may make 
and run a “Data Entry File” as explained in that topic as well as other plotting routines.  
PRINTER PLOTTING ANNOTATION DOES NOT WORK PROPERLY WITH ALL 
PRINTERS. HOWEVER, THE LINE WORK IS ACCURATE. 
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The ability to use Azimuths in LotPlot has now been added.  It will first have to be selected 
from the Options menu.  If annotation is selected it annotates with azimuths rather than 
bearings.  The use of the data entry file to save the plot is explained as follows: 
 
1. Select 'Data Entry Files' on top menu. Select LotPlot, Make File. 
2. Name the file. 
3. Check the 'Enable Printer' box if printed plot is needed. Also select printer annotation if 
wanted. If not, they can be selected when the ‘Run File’ is used subsequently. 
4. Enter a scale. Later plots may use a different scale than the first one. 
5. Click a spot in the plotting area that will begin the plot. 
6. Enter your bearing/azimuths and distances. 
8. Click 'Plot to Printer' if a printed plot is made. 
9. You come back tomorrow and want to re-plot. 
10. Make sure you have selected the 'Azimuth' option if that mode is used. 
11. Check 'Enable Printer' box if printed plot needed.  Also printer annotation is desired. 
12. Enter scale (MUST have one but doesn't have to be same as the first time) 
13. Click in the plotting box. MUST be done before running saved file. 
14. Select 'Data Entry Files', Lot Plot, Run file. 
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15. The plot will appear from the point entered in (13) 
17. Click 'Plot to Printer' if plotting to printer. 
17. Reset the plot if you do this immediately after the first time. 
 
There is a ‘Hdg’ check box near the bottom of the screen.  When checked, you may enter 
text that will be printed as part of a title for your drawing.  You may enter 2 items, like the 
name of the drawing and your name or company for the first 2 lines.  The next 2 lines show 
the scale and the date.  This title will appear near the lower right corner of the sheet when 
the drawing is plotted. It may be left off by not checking the box.  If you have saved the plot 
with a name using ‘data entry files’, you may plot several copies of the drawing without re-
entering the title’s text.  However, if you have closed the LotPlot routine and come back 
later to re-plot from your saved file, you will have to re-enter the first 2 lines again. 
 
RADIAL PLOTTING 
The radial plotting routine simply plots the points in relationship to the control point. You 
must have at least the occupied and sighted points. The base line is shown as a dashed 
line on the screen for the first angle only.  The details are similar to those for the angle-
distance traverse plot except there is no automatic sizing of the plot because it originates 
from a constant point. However, a text file is still created with “radplot.txt” added. When 
selected from the Plotting menu, the Plotting limits window appears in which to set the 
limits.  Try to estimate the extents of the plot.  You may have to increase or decrease them 
as you proceed. This is not a problem since your data is stored in the text file and can be 
re-plotted.  The ‘Plot File’ button is used to replot the file prior to printer plotting as 
described in bearing-distance and angle-distance plotting.  Elevations and descriptors are 
not carried in the text file created. You might also consider using “Interactive Plot” after 
entering your data with Radial, without using “Radial Plot”.  After all of the points have been 
entered WITHOUT plotting, they can be viewed in the “Interactive” plot routine.  To printer-
plot, set the printer coordinates on the “Plotting Limits” screen.  
 
A typical example may be as follows, assuming the setup and sighted points are in the file: 
1. Open the radial routine 
2. Select ‘Radial Plot’ from the Plotting menu. 
3. Choose your limits 
4. Enter your data as usual and see the points with their numbers plot on the screen 
5. Printer plot by checking the ‘Limits for printer plot’ box.   
6. Note that the ‘Top Left Coords’ are entered under PRINTER 
7. Enter a scale (20,30,50, etc.) The bottom right are automatically entered. Click OK 
8. When returned to the previous screen where the points have been plotted, click the ‘Plot 

File’ button to replot the points with the printer ‘turned on’. 
9. Press Ctrl+F7 or select from the Plotting menu to plot the points to the printer at the 

scale selected. 
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AREA PLOTTING 
This routine plots the lines only for the legs of the closed figure.  It does not plot the curves 
but only the chords between the points of curve.  However, the area is computed using the 
curve information you enter.  You can either show point numbers or not and plot to the 
printer.  You must go clockwise if curves are involved. You could reasonably plot a 
subdivision using the points for each lot. 
 
 
FUNCTION KEYS 
 
F1  Activates Help topics window.            
Ctrl + F1     Activates help for the subject routine. 
Ctrl + F6 Activate printer plot 
Ctrl + F7 Send plot to printer (Not all plotting routines) 
Ctrl + F8 Clear plotting screen 
Ctrl+F9  Activates bearing-distance traverse from anywhere 
Ctrl+F12 Toggles button bar off/on 
F8  View name of active coordinate file 
F9  View high point number and unused points  
F11  Activates Inverse by point numbers from anywhere 
F12  Activates Inverse by coordinates from anywhere 
Ctrl+A  Angle-Dist traverse 
Ctrl+B  Embedded routines 
Ctrl+C  Copy selected text 
Ctrl+D  Delete 
Ctrl+F            Find by descriptor 
Ctrl+H   Other inverse display  
Ctrl+I  Interactive point plot 
Ctrl+L  List 
Ctrl+M Map Check 
Ctrl+O  Open file 
Ctrl+P  Print dialogue 
Ctrl+Q  Display in tenths of seconds  
Ctrl+T  Lot Plot 
Ctrl+U  Curve calculations 
Ctrl+V  Paste text 
Ctrl+X  Cut Text 
Ctrl+Z  Exit Plotting 
 
 
  
 


